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Preface

As part of an effort to improve product lines, periodic revisions of software and
hardware are released. Therefore, all versions of the software or hardware currently in
use might not support some functions that are described in this document. The
product release notes provide the most up-to-date information on product features.

If a product does not function correctly or does not function as described in this
document, contact a technical support professional.

Note

This document was accurate at publication time. To ensure that you are using the
latest version of this document, go to the Support website https://www.dell.com/
support.

Purpose
This guide contains information about using the NetWorker Module for Microsoft
(NMM) 19.1 software to back up and recover Microsoft Exchange Server using the
Volume Shadow Copy Service (VSS) technology.

Note

The NetWorker Module for Microsoft Administration Guide supplements the backup and
recovery procedures described in this guide and must be referred to when performing
application-specific tasks. Ensure to download a copy of the NetWorker Module for
Microsoft Administration Guide from the Support website at https://support.emc.com
before using this guide.

Audience
This guide is part of the NetWorker Module for Microsoft documentation set and is
intended for use by system administrators during the setup and maintenance of the
product. Readers should be familiar with the following technologies used in backup
and recovery:

l NetWorker software

l NetWorker data protection policy management

l Microsoft Volume Shadow Copy Service (VSS) technology

NetWorker Module for Microsoft for Exchange Server VSS 19.1  User Guide 11
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Revision history
The following table presents the revision history of this document.

Table 1 Revision history

Revision Date Description

01 May 20, 2019 First release of this document for the NetWorker
Module for Microsoft 19.1 release.

Related documentation
The NMM documentation set includes the following publications:

l NetWorker Module for Microsoft Release Notes

l NetWorker Module for Microsoft Administration Guide

l NetWorker Module for Microsoft Installation Guide

l NetWorker Module for Microsoft for SQL and SharePoint VSS User Guide

l NetWorker Module for Microsoft for SQL VDI User Guide

l NetWorker Module for Microsoft for Exchange VSS User Guide

l NetWorker Module for Microsoft for Hyper-V User Guide

l ItemPoint for Microsoft SQL Server User Guide

l ItemPoint for Microsoft Exchange Server User Guide

l ItemPoint for Microsoft SharePoint Server User Guide

l NetWorker documentation set

Special notice conventions that are used in this document
The following conventions are used for special notices:

NOTICE

Identifies content that warns of potential business or data loss.

Note

Contains information that is incidental, but not essential, to the topic.

Typographical conventions
The following type style conventions are used in this document:

Table 2 Style conventions

Bold Used for interface elements that a user specifically selects or clicks,
for example, names of buttons, fields, tab names, and menu paths.
Also used for the name of a dialog box, page, pane, screen area with
title, table label, and window.

Italic Used for full titles of publications that are referenced in text.

Monospace Used for:

l System code

l System output, such as an error message or script

Preface
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Table 2 Style conventions (continued)

l Pathnames, file names, file name extensions, prompts, and
syntax

l Commands and options

Monospace italic Used for variables.

Monospace bold Used for user input.

[ ] Square brackets enclose optional values.

| Vertical line indicates alternate selections. The vertical line means or
for the alternate selections.

{ } Braces enclose content that the user must specify, such as x, y, or z.

... Ellipses indicate non-essential information that is omitted from the
example.

You can use the following resources to find more information about this product,
obtain support, and provide feedback.

Where to find product documentation

l https://www.dell.com/support

l https://community.emc.com

Where to get support
The Support website https://www.dell.com/support provides access to product
licensing, documentation, advisories, downloads, and how-to and troubleshooting
information. The information can enable you to resolve a product issue before you
contact Support.

To access a product-specific page:

1. Go to https://www.dell.com/support.

2. In the search box, type a product name, and then from the list that appears, select
the product.

Knowledgebase
The Knowledgebase contains applicable solutions that you can search for either by
solution number (for example, KB000xxxxxx) or by keyword.

To search the Knowledgebase:

1. Go to https://www.dell.com/support.

2. On the Support tab, click Knowledge Base.

3. In the search box, type either the solution number or keywords. Optionally, you
can limit the search to specific products by typing a product name in the search
box, and then selecting the product from the list that appears.

Live chat
To participate in a live interactive chat with a support agent:

1. Go to https://www.dell.com/support.

2. On the Support tab, click Contact Support.

3. On the Contact Information page, click the relevant support, and then proceed.

Preface
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Service requests
To obtain in-depth help from Licensing, submit a service request. To submit a service
request:

1. Go to https://www.dell.com/support.

2. On the Support tab, click Service Requests.

Note

To create a service request, you must have a valid support agreement. For details
about either an account or obtaining a valid support agreement, contact a sales
representative. To get the details of a service request, in the Service Request
Number field, type the service request number, and then click the right arrow.

To review an open service request:

1. Go to https://www.dell.com/support.

2. On the Support tab, click Service Requests.

3. On the Service Requests page, under Manage Your Service Requests, click
View All Dell Service Requests.

Online communities
For peer contacts, conversations, and content on product support and solutions, go to
the Community Network https://community.emc.com. Interactively engage with
customers, partners, and certified professionals online.

How to provide feedback
Feedback helps to improve the accuracy, organization, and overall quality of
publications. You can send feedback to DPAD.Doc.Feedback@emc.com.

Preface
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CHAPTER 1

Introduction

This chapter includes the following sections:

l Overview............................................................................................................ 16
l Using NMM in an Exchange Server environment............................................... 20
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Overview
The NetWorker Module for Microsoft (NMM) software supports backup and recovery
for Microsoft Exchange Server 2010, 2013, 2016, and 2019 databases in stand-alone
and database availability group (DAG) configurations.

It is recommended that you review the NetWorker E-LAB Navigator at https://
elabnavigator.emc.com/eln/elnhome. The NetWorker E-LAB Navigator lists the most
up-to-date information about supported Windows Server versions.

NMM 19.1 compatibility with NetWorker 8.2.3 or 8.2.4 servers
NMM supports backup and recovery with NetWorker client version 19.1 and
NetWorker server version 8.2.3 or 8.2.4.

The NetWorker Module for Microsoft Installation Guide contains the NMM support
matrix for NetWorker server and client versions. For more details, see the individual
NMM release sections of the NetWorker E-LAB Navigator , which is available at 
https://elabnavigator.emc.com/eln/elnhome.

Note the following limitations when you configure NMM backup and recovery with an
NMM 19.1 client and a NetWorker 8.2.3 or 8.2.4 server:

l Dedicated Storage Node: NetWorker 8.2.3 and 8.2.4 servers do not support
NetWorker storage node 19.1. As a result, you cannot configure a dedicated
storage node when you use NetWorker 19.1 client with NetWorker 8.2.3 or 8.2.4
server.

l Backup levels: NetWorker 8.2.3 and 8.2.4 servers use NetWorker server 8.x
backup-level definitions, and do not support the NetWorker server version 9.x and
later backup levels.

Stand-alone or single Exchange Servers
In a stand-alone or single Exchange Server environment, all mailbox databases, log
files, and checkpoint files exist on one server.

NMM is installed on the Exchange server.

The following figure illustrates the relationship between the NetWorker Server,
NetWorker Management Console (NMC), and NMM client installation in a single
Exchange server environment. NMM is installed on the Exchange server.

Introduction
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Figure 1 NetWorker and NMM installation in a stand-alone or single Exchange Server
environment

Exchange Server DAGs
NMM supports Exchange Server database availability groups (DAGs) for high
availability of Exchange Server backups.

Review the following considerations for using NMM in an Exchange Server DAG
environment:

l Install the NetWorker and NMM clients on each Exchange Server that has the
mailbox role installed.

l When there are multiple copies of a database, only one copy of the database is
active at a time. The remaining copies are passive.

l You can back up active copy mailbox databases, passive copy mailbox databases,
and stand-alone databases.

l Stand-alone applies to an Exchange Server mailbox database that is not replicated
across multiple servers, including public folder mailboxes and public folder
databases.

l You can only restore backups of databases in a DAG environment to active
database copies.
The Microsoft TechNet website provides additional information about the
Exchange DAG architecture.

The following figure illustrates the relationship between the NetWorker Server,
NetWorker Management Console, and an Exchange Server DAG. The NMM client
is installed on each Exchange Server in the DAG.

Introduction
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Figure 2 NetWorker and NMM installation with a DAG in an Exchange Server environment

The topic Roadmap for configuring Exchange Server backups on page 41 provides
information about configuring a DAG backup after you install the NetWorker and
NMM clients on each Exchange Server in the cluster.

High availability in Exchange Server
Larger enterprises typically deploy Exchange Server in some form of high-availability
configuration.

Exchange Server 2010, 2013, 2016, and 2019 typically include the use of database
availability groups (DAGs) and mailbox database copies. You are not required to install
and configure any Windows clustering before you install Exchange Server.

You can add high availability to the Exchange Server environment after you deploy
Exchange Server without uninstalling Exchange Server and then reinstalling it in a
high-availability configuration. These improvements in high availability and site
resilience functionality also simplify installation and configuration of the NetWorker
and NMM clients for backup and recovery.

Introduction
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Federated IP-less DAG backup
NMM supports backups of Exchange DAG databases with no administrative access
point.

This DAG type is not linked to any physical or virtual IP that can be connected on the
network. An existing DAG (IP-based) cannot be converted to an IP-less DAG. Refer to
the Backup chapter for more information on IP-less DAG backup configuration.

DAG AutoReseed
NMM supports AutoReseed configuration on Exchange server 2013 SP1 and later.

AutoReseed is a DAG feature that quickly restores database redundancy after a disk
failure, database corruption, or other event that requires reseeding of a database
copy. If the database is compromised, the database copies that are stored on the disk
automatically reseed to a preconfigured spare disk on the mailbox server.

For more information about the AutoReseed feature and how to configure a DAG with
AutoReseed, refer to the following article:

https://technet.microsoft.com/en-us/library/dn789209(v=exchg.150).aspx

Active and passive databases
This topic describes NMM installations with Exchange Server 2010 and later clustered
environments.

Active and passive copies of the databases exist in a clustered environment. The
Exchange Server constantly updates a copy or a replica as the passive copy. For
backups, the passive copy enables you to back up the databases without affecting the
performance or data of the active copy. You must designate individual databases as
either active or passive. This action enables you to have a mix of active and passive
databases on each node.

The following figure shows an Exchange Server DAG environment with four mailbox
databases (DB1, DB2, DB3, and DB4). Active and passive copies of these databases
are spread over three nodes (servers MBX1, MBX2, and MBX3).

Introduction
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Figure 3 Exchange Server DAG environment

Roadmap of configuring Exchange backups provides detailed steps for configuring the
NMM client on the active node after you install the NMM client on each Exchange
Server in the cluster.

Shadow copy and log truncation
Shadow-copy creation is separate from the notification to VSS writers that the
backup is complete. NMM registers the shadow copy as a snapshot and backs it up to
media before the notification is sent to the VSS writers. If the backup to media fails,
that failure is reported to the Exchange VSS writer and log truncation does not occur.

Client Direct feature
The Client Direct feature enables clients that have a direct network or a DD Boost
over Fibre Channel (DFC) connection to the Data Domain system to send and receive
data directly to an AFTD or a DD Boost device. Client Direct supports multiple
concurrent backup and restore operations that bypass the NetWorker storage node,
which eliminates a potential bottleneck. The storage node manages the devices that
the clients use, but it does not handle the backup data. Client Direct was previously
known as Direct File Access (DFA).

When the connection is available, NMM enables Client Direct by default and uses
Client Direct to recover duplicated backups that NMM had performed with a storage
node.

Using NMM in an Exchange Server environment
NMM in an Exchange Server environment supports multiple backup and recovery
types, VSS writers, and is compatible with Exchange Server backups from previous
versions of NMM.

Introduction
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Exchange Server 2010 VSS writers
Exchange Server 2010 has two writers for active and passive databases. NMM uses
these writers during backup and recovery. The following table provides details.

Table 3 Writers used by NMM for Exchange Server backup and recovery

Application
writers

Description

Information Store
Writer

This writer is built into the Exchange Information Store. The
Information Store Writer is available on any mailbox server, and is
responsible for backup and recovery of active databases.

Replication Service
Writer

This writer is built into the Replication Service. The Replication
Service Writer is available on the passive node of DAGs.

The Replication Service Writer supports backup functionality for a
selected database where the shadow copy is taken against the
replicated instance of the database and transaction log files. You can
use the Information Store Writer to restore Replication Writer
backups to the active database location.

Exchange Server 2013, 2016, and 2019 VSS Writer
Exchange Server 2013, 2016, and 2019 have one writer for active and passive
databases: Microsoft Exchange Server Writer. NMM uses the Microsoft Exchange
Server Writer during backup and recovery. Exchange Server-aware VSS-based
applications use this writer to back up active and passive database copies and to
restore backed-up database copies.

Although this writer runs in the Microsoft Exchange Replication service, it requires the
Microsoft Exchange Information Store service to be running so that the writer is
advertised. As a result, both services are required to back up or restore Exchange
Server databases.

Compatibility with previous Exchange backups
To perform recovery from NMM version 8.2.x or earlier, select the Restore of NMM
8.2.x and Earlier Backups (VSS workflows) option in the NMM installer. The
NetWorker Module for Microsoft Installation Guide provides more information.

NetWorker Module for Exchange (NME) uses VDI technology and NMM uses VSS
technology. As a result, you cannot directly recover data from an NME backup using
NMM. If you upgraded to NMM from NME, perform a full backup of the Exchange
Server using NMM to perform point-in-time recovery in the future.

Note

To ensure successful recovery, it is recommended that you perform a full backup
before and after you update the Exchange Server, including service pack updates.

Introduction
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Backup-initiated transaction log file truncation
The Microsoft Exchange Server Writer is responsible for truncating transaction logs.

NMM notifies the Exchange Server Writer that a backup has completed successfully,
which allows the Exchange Server Writer to continue with log truncation.

The specific point at which the Exchange Server Writer starts backup-initiated log file
truncation differs for each backup type:

l In stand-alone configurations, the Exchange Server Writer truncates the
transaction log files when successful full or incremental backups complete.

l In DAG configurations, the Microsoft Exchange Replication service delays the log
truncation until all necessary log files are replayed into all other copies. After the
Microsoft Exchange Replication service verifies that the to-be-deleted log files
have been applied to the copy database and active and passive databases, the
Replication service deletes the backed-up log files from both the active and
passive copy log file paths.

Backup types and levels
The Exchange Server block-based backup is the default and only method to back up
an Exchange Server with NMM.

NMM uses NetWorker block-based backup technology to perform backups of stand-
alone and DAG Exchange environments. Block-based technology tracks changed
blocks of the Exchange database and log files. When a level incremental backup is
started, only the changed blocks are backed up. When a level full backup is started,
each selected Exchange database and all necessary log files are backed up.

The following table provides information about NetWorker backup levels and the
resulting backup levels for Exchange Server backups:

Table 4 Exchange backup types and levels

Target device type Supported backup levels Resulting save set level

Data Domain device Full Full

Incremental Full

AFTD Full Full

Incremental Incremental

Note

Logs-only and synthetic-incremental backup levels are not supported with Exchange
server backups.

The NetWorker Module for Microsoft Administration Guide provides more details about
backup levels and block-based backup.
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Federated DAG backups
NMM supports federated backups for Exchange Server DAGs and IP-less DAGs,
including stand-alone and public folder databases.

Federated backups allow you to back up all databases in a DAG with a single save set
across all Exchange Server nodes in the DAG. NMM does not require that you back up
each node separately.

Note

NMM does not support backup operations for individual mailbox servers within a DAG.
Non-federated backups are supported for stand-alone configurations only

Recovery types
NMM supports the following types of recovery:

l Roll-forward recovery

l Point-in-time recovery

l Database recovery to an Exchange recovery database

l Remote database recovery for an Exchange Server database availability group
(DAG)

l Exchange RDB mailbox browsing, mailbox, folder, and message recovery

l Recovery to alternate mailbox database

l Recovery to alternate mailbox

l Granular-level recovery to/from a recovery database

l Granular-level recovery to alternate mailbox

l Granular-level recovery to PST files

Note

Browsing a recovery database for granular-level recovery using MAPI is not supported
with Exchange Server 2016. Granular-level recovery of Exchange Server 2016 is
supported only through ItemPoint™ for Microsoft Exchange Server. See the Granular-
Level Recovery chapter for more information.

Introduction
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CHAPTER 2

Configuration

This chapter includes the following sections:

l Supported Exchange Server deployment scenarios and limitations....................26
l Configuring users to perform NMM Exchange Server operations...................... 26
l NMM requirements for MAPI client and collaboration data objects................... 35
l Exchange consistency check............................................................................. 35
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Supported Exchange Server deployment scenarios and
limitations

The Microsoft Exchange Server documentation provides a complete and updated list
of system requirements and supported configurations.

The NetWorker E-LAB Navigator , available at https://elabnavigator.emc.com/eln/
elnhome, provides the most up-to-date and accurate listing of hardware, operating
system, service pack, and application versions that NMM supports.

Supported Exchange Server versions
The latest NetWorker E-LAB Navigator at https://elabnavigator.emc.com/eln/elnhome
provides up-to-date information about the versions of Exchange Server and Windows
Server that NMM supports for stand-alone, DAG, and passive/active highly available
deployments.

Microsoft Exchange Server and Microsoft SharePoint Server installation on
the same host

Microsoft does not support the installation of Microsoft Exchange Server and
Microsoft SharePoint Server on the same host.

Configuring users to perform NMM Exchange Server
operations

In order to protect an Exchange Server or database availability group (DAG) with
NMM, you must configure an account with the required privileges.

NMM Exchange Admin Configuration tool
The NMM Exchange Admin Configuration tool enables you to create or reset account
permissions with the necessary privileges to perform backup and recovery operations
on an Exchange Server. After installing NMM, use the tool to create an account, or to
modify, validate, and update existing account privileges.

You must configure a user after installing NMM. When NMM is installed with the
NMM Installation wizard, the NMM Exchange Admin Configuration tool runs
automatically. When NMM is installed silently, you must manually open the NMM
Exchange Admin Configuration tool.

To use the NMM Exchange Admin Configuration tool, you must be logged in with
domain administrator permissions. You can use a non-administrative user to run the
NMM Exchange Admin Configuration tool only if you select Skip Active Directory
Authentication and configure the user with the tool on each Exchange Server node.

You can use the Exchange NMM Admin Tool to create users, configure existing users,
and assign correct permissions to existing users. NMM uses the user account that is
set in the registry by the NMM Exchange Admin Configuration tool to perform
backup, database, or granular-level recovery.

The following figure shows the NMM Exchange Admin Configuration tool landing
page.
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Figure 4 NMM Exchange Admin Configuration tool

NMM Exchange Admin Configuration tool operations
The NMM Exchange Admin Configuration tool simplifies configuring security group
memberships by ensuring that users have all the required Active Directory security
group memberships and PowerShell management roles.

You can assign users to an Organization Management role, or you can assign them to
the NMM Exchange Admin Role group. If you assign a user to the NMM Exchange
Admin Role group, that user is removed from the Organization Management role.
Conversely, if you assign a user to the Organization Management role, that user is
removed from the NMM Exchange Admin Role group. The NMM Exchange Admin
Role group is not created unless at least one user is configured without Organization
Management rights.

To create an NMM Exchange Administrator account, the tool automatically performs
the following steps:

1. Creates an Active Directory user account.

2. Creates a custom Exchange security group.

3. Adds the NMM Exchange Administrator account to the user groups listed in the
following table.

Table 5 User group roles configured by the NMM Exchange Admin Configuration tool

User group Exchange Server role

Security group memberships on NMM Client
computer

Local Administrator

Security group memberships on Domain
Controller

l Backup Operators

l Remote Desktop Users

Exchange Security Group memberships l Exchange Servers

l Organization Management or NMM
Exchange Admin Roles

l NMM Exchange Admin Roles include:

n Database Copies

n Databases

n Disaster Recovery

n Mailbox Import Export
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Table 5 User group roles configured by the NMM Exchange Admin Configuration
tool (continued)

User group Exchange Server role

n Mail Recipient Creation

n Mail Recipients

n View-Only Configuration

n View-Only Recipients

4. Assigns the Mailbox Import Export management role to the user.

5. Creates an Exchange mailbox.

6. Assigns Send-As and Receive-As rights.

7. Registers the user account for backup and recovery on Exchange servers where
NMM is installed.

Configuring an administrative user
You can perform the following actions after clicking Configure Admin User:

l Create an NMM Exchange Admin user, configure the permissions that are required
for Exchange backup and recovery (both database and GLR), and set the user
account in the registry.

l Update an existing Exchange Admin user's permissions to those that are required
for Exchange backup and recovery (both database and GLR), and set the NMM
Exchange administrator account in the registry.

l Set an existing user as an NMM Exchange Admin account in the registry.

The following figure shows the NMM Exchange Admin Configuration tool Configure
Admin User page.

Figure 5 Configuring an administrative user
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Configure an administrative Exchange backup account
You can configure an administrator user with the NMM Exchange Admin Configuration
tool by creating an account, or by using an existing account.

Procedure

1. In the NMM Exchange Admin Configuration window, click Configure Admin
User.

2. Under Action, select one of the following options:

l Create new admin—Create an Exchange user account for NMM backup
and recovery operations.

l Configure existing user—Use an existing Exchange user account for NMM
backup and recovery operations.

3. Type the User Name and Password.

4. If you are creating an account:

a. In the Confirm Password field, retype the password.

b. From the Database list, select the Exchange database for which the user will
perform backups and recoveries.

5. (Optional) Select Assign Organization Management rights.

Members of the Organization Management role group have permissions to
manage Exchange objects and their properties in the Exchange organization.
Members can also delegate role groups and management roles in the
organization.

Note

If you select Assign Organization Management rights, NMM adds the user to
the Organization Management group. The tool does not create an NMM
Exchange Admin Roles security group.

If you do not select this option and also do not select the Skip Active Directory
Authentication option, NMM will create an Active Directory security group
called EMC NMM Exchange Admin Roles and add the user to that group.

6. (Optional) Select Create ContentSubmitters security group.

This option creates a ContentSubmitters Active Directory security group. This
option is unavailable if a ContentSubmitters group is already created in the
Active Directory. This option is available only on Exchange Server 2013 and
later.

7. (Optional) If you are configuring an existing user, select Skip Active Directory
Authentication.

This option skips the Active Directory authentication and authorization
operations for the user, and only sets the user as the NMM Exchange user
account in the registry for backup and recovery operations.
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Note

This option should be selected when you manually configure a user. See the
example "Manually configuring an Exchange backup Admin user" in the section 
Examples of administrative user configurations on page 30 for more
information about this configuration.

8. Click Configure.

The output window shows the status of the configure operation, including any
warning or error messages.

9. (Optional) To verify that all the configurations are correctly set, run the System
Configuration Checker.

Results

The user receives the necessary permissions to backup and restore the Exchange
database.

Configuring an administrator in a parent and child domain environment
Consider the following when configuring a user in a parent and child domain
environment.

When the NMM Exchange Admin Configuration Tool is run on a node that is part of a
child domain to configure a user in a parent and child domain environment, the user is
added to the Active Directory of the child mailbox server. The user inherits security
group memberships from the parent domain.

The NMM Exchange Admin Configuration Tool does not support user configurations
for the following scenarios:

l To create a user in the parent Active Directory from a child mailbox server.

l To create a user in the child Active Directory from a parent mailbox server.

l To create a user from a child or parent mailbox server in a different domain of the
same forest.

Manually configure a user in these scenarios. See the example "Manually configuring
an Exchange backup Admin user" in the section Examples of administrative user
configurations on page 30 for more information about this configuration.

Examples of administrative user configurations
This section provides examples of configuring an administrator with the NMM
Exchange Admin Configuration tool.

Example 1  Configuring or modifying an Admin user with Organization Management rights

The user will be a member of the Organization Management group, but will not be a
member of the EMC Exchange NMM Admin Roles group.

1. In the NMM Exchange Admin Configuration window, click Configure Admin
User.

2. Complete the Configure Admin User page, and then select Assign Organization
Management rights.

3. Click Configure.
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Example 1  Configuring or modifying an Admin user with Organization Management rights
 (continued)

4. Verify that all the configurations are correctly set, System Configuration Checker.

Example 2  Configuring or modifying an Admin user without Organization Management rights

The user will be a member of the EMC Exchange NMM Admin Roles group, but will not
be a member of the Organization Management group.

1. In the NMM Exchange Admin Configuration window, click Configure Admin
User.

2. Complete the Configure Admin User page. Ensure that Assign Organization
Management rights is not selected.

3. Click Configure.

4. Verify that all the configurations are correctly set by running the System
Configuration Checker.

Example 3  Manually configuring an Exchange backup Admin user

1. Configure the user manually in Active Directory, and ensure that the user has the
appropriate roles and rights, as described in NMM Exchange Admin Configuration
tool on page 26.

2. In the NMM Exchange Admin Configuration window, click Configure Admin
User.

3. On the Configure Admin User page:

a. Select Configure Existing User.

b. In the User Name and Password fields, type the required information.

c. Select Skip Active Directory Authentication.

d. Click Configure.

4. Verify that all the configurations are correctly set by running the System
Configuration Checker.

Configuring a non-administrative user
You can create an Exchange backup user with non-administrative privileges.

In order to configure a non-admin Windows user to perform Exchange protection
operations, you must create a domain user and assign that user the required privileges
with the NMM Exchange Admin Configuration tool.

Note

You can use a non-administrative user to run the NMM Exchange Admin Configuration
tool only if you select Skip Active Directory Authentication and configure the user
with the tool on each Exchange Server node.
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Creating a non-administrative domain account for creating Exchange backup users
You can create Exchange backup users with a non-administrative Windows account if
it is configured with the required privileges.

Before you begin

You must be logged in to a domain controller as an administrative domain user.

Procedure

1. Create a new domain user.

Once created, the user is listed in the Active Directory Users and Computers
window.

2. Open the user Properties window, and in the Members Of tab, ensure that the
user is added to the following user groups:

User right Description

Remote Desktop Users Allows the user to remotely connect to a domain
controller.

Account Operators Allows the user to create domain user accounts.

The user is also a member of the Domain Users group by default.

3. Open the Group Policy Management Editor window and navigate to
Domains > Choose Domain > Domain Controllers.

4. Right-click Domain Controllers Policy and select Edit > Choose Computer
Configuration > Policies > Windows Settings > Security Settings > Local
policies > User Rights Assignment.

5. On the Local Policies page, grant the user the following rights:

User right Description

Allow log on locally Allows the user to log on to all domain controllers
in the domain.

Allow log on through
Remote Desktop Services

Allows the user to log on to all domain controllers
in the domain through Remote Desktop Services.

6. To apply the changes, log out of the domain controller.

Configure a non-administrative Exchange backup account
You can use the NMM Exchange Admin Configuration tool to configure a non-
administrative Windows account to perform Exchange backup and recovery.

Before you begin

Log in to a domain controller with a user who can create domain accounts. Creating a
non-administrative domain account for creating Exchange backup users on page 32
Provides details on how to configure a non-administrative user with the required
privileges.

Procedure

1. Create a new domain user.

Once created, the user is listed in the Active Directory Users and Computers
window.
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2. Open the user Properties window, and in the Members Of tab, ensure that the
user is added to the following user groups:

User right Description

Remote Desktop Users Allows the user to remotely connect to a domain
controller.

Organization Management Allows the user administrative access to the
Exchange organization.

The user is also a member of the Domain Users group by default.

3. Perform the following steps on each Exchange Server that you want to back up,
including all servers that are part of a database availability group (DAG):

a. Log on to the Exchange Server as a local Administrator.

b. In Computer Management > Local Users and Groups, add the new user to
the Administrators group.

c. To apply the changes, log out of the Exchange Server.

d. Log on to the Exchange Server as the new user.

e. Launch the NMM Exchange Admin Configuration tool.

f. In the NMM Exchange Admin Configuration tool window, click Configure
Admin User.

g. On the Configure Admin User page, perform the following actions:

a. Select Configure existing user.

b. Enter the credentials for the user created in step 1.

c. Select Skip Active Directory Authentication.

Note

Do not select Assign Organization Management rights, otherwise the
configuration will fail.

d. Click Configure.

Results

The user is set in the registry and assigned the non-administrative permissions that
are required for Exchange backup and recovery.

Update Admin Password
Click Update Admin Password to modify the NMM Exchange administrator account
password and update the registry.

Validate an existing Admin
Click Validate an existing Admin to verify that an existing NMM Exchange
administrator account is correctly configured.

The following figure shows the NMM Exchange Admin Configuration tool Validate an
existing Admin page.
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Figure 6 Validating an existing administrative user

Validating an existing administrator
Use the NMM Exchange Admin Configuration tool to verify that an existing NMM
Exchange administrator account is correctly configured.

Note

Validating an existing administrator may fail in the following scenarios:

l When you use a non-administrative user.

l In a parent and child domain environment. The operation can fail because the tool
might try to contact Active Directory to validate credentials from the registry.

Procedure

1. In the NMM Exchange Admin Configuration window, click Validate an
existing Admin.

2. In the User Name and Password fields, type the required information.

3. Click Validate.

A window that lists the Exchange servers in your environment opens.

4. Select each server that the user must back up or recover, and then click OK.

The window closes and the validate operation starts. The output window shows
the status of the operation including any warning or error messages.

Results

The output window shows the results of the validate operation.
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NMM requirements for MAPI client and collaboration data
objects

NMM requires Microsoft Exchange Server MAPI Client and Collaboration Data
Objects 1.2.1 Kit for granular-level recovery (GLR) of Exchange Servers through the
NMM UI.

Note

NMM also supports GLR of Exchange Servers with ItemPoint for Microsoft Exchange
Server. It is recommended that you use ItemPoint for Microsoft Exchange Server for
GLR instead of the NMM UI. See the "Exchange server GLR using ItemPoint" section
in the NetWorker Module for Microsoft for Exchange VSS User Guide for the required
Outlook version. If you use ItemPoint for Microsoft Exchange Server, MAPI is not
required for GLR.

The following table outlines the MAPI/CDO version requirements with different
versions of Exchange Server.

Table 6 Exchange Server GLR MAPI/CDO requirements

Exchange Server version Required MAPI/CDO version

Exchange Server 2010 MAPI/CDO 1.2.1 version 6.5.8244.0 or earlier

Exchange Server 2013 MAPI/CDO 1.2.1 version 6.5.8353.0 or later

Exchange Server 2016 Not applicable
GLR of Exchange Server 2016 is supported only through
ItemPoint for Microsoft Exchange Server.

Exchange Server 2019 Not applicable
GLR of Exchange Server 2019 is supported only through
ItemPoint for Microsoft Exchange Server.

The Exchange Server 2010 and 2013 software does not include the MAPI client
libraries and CDO. You can download the client library and CDO package from
Microsoft’s website. For information about downloading and installing this software,
search for "Microsoft Exchange MAPI Client and Collaboration Data Objects" on the
Microsoft Download Center website.

The NetWorker E-LAB Navigator at https://elabnavigator.emc.com/eln/elnhome
contains information about the most recent version of the MAPI and CDO kit that
NMM supports.

Exchange consistency check
Exchange consistency checks improve the quality and performance of a backup
operation.

The Exchange consistency check occurs at the time of a backup operation and verifies
that the database and its corresponding set of transaction logs do not contain errors
(such as on-disk data corruption). This feature validates that the Exchange backup is
viable and will not cause issues when it is restored.

Configuration

NMM requirements for MAPI client and collaboration data objects     35

https://elabnavigator.emc.com/eln/elnhome


You can configure a consistency check to check the database and log files, only the
database files, or only the log files. A consistency check of only the database does not
ensure complete consistency of the backup, but it does take less time to perform this
type of consistency check.

Consistency check parameters for threading and throttling
The larger the databases and associated transaction logs, the longer it takes to run a
consistency check. To reduce the amount of time it takes to perform a consistency
check on large databases, NMM provides the option to run a consistency check on
multiple databases in parallel.

NMM provides throttling parameters to govern the use of system resources during a
consistency check. While the default throttling limit is 1000 ms, you can set the
throttle limit according to the setup. If you run simultaneous consistency checks
without adjusting the throttle limits, the Exchange server performance can suffer. In
extreme cases, the I/O bottlenecks cause the consistency checks to fail and other
system operations are adversely affected.

You can configure threading and throttling to prevent performance issues during
backup. Use the attribute values from the following table in the Application
Information field of the NMM client.

Table 7 Exchange application information variables for threading and throttling

Attribute name Description Default and valid values

NSR_ESE_UTIL_SEQUENTIAL Optional, specifies
whether to run Eseutil in
parallel (multi-threaded)
or sequentially (single-
threaded).

l False (default)—Runs

eseutil in parallel

(multi-threaded) with a
default maximum of 4
parallel threads.

l True—Runs eseutil
sequentially (single-
threaded).

l number_of_threads—

Specifies the number of
parallel threads to use.
For example:
NSR_ESE_UTIL_SEQUEN
TIAL=6

NSR_ESE_UTIL_THROTTLE Optional, specifies
whether to allow
throttling.

l False (default)—

Prevents eseutil
throttling, ignoring all
other throttling
parameters.

l True—To Allows

eseutil throttling.

NSR_ESE_THROTTLE_IOS Optional, specifies the
number of I/Os between
pauses when throttling.
This attribute is useful to
limit disk utilization.

l Undefined (default)—The
default value is 100.

l Valid defined values are
100–10000. For example:
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Table 7 Exchange application information variables for threading and throttling  (continued)

Attribute name Description Default and valid values

NSR_ESE_THROTTLE_IO
S=500

NSR_ESE_THROTTLE_DURATION Optional, specifies the
duration of pause in
milliseconds when
throttling. This attribute
is useful to limit CPU
utilization.

l Undefined (default)—The
default value is 1000.

l Valid defined values are
1000–60000.

NSR_ESE_CC_METHOD Optional, specifies
whether to perform the
consistency check on the
database and log files,
database file only, or log
files only.

l DB_AND_LOGS (default)

—Performs a consistency
check on the database
and log files.

l DB_ONLY—Performs a

consistency check on the
database files only.

l LOGS_ONLY—Performs a

consistency check on the
log files only.
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CHAPTER 3

Exchange Server Backup Operations

This chapter includes the following sections:

l Planning Exchange Server backups....................................................................40
l Roadmap for configuring Exchange Server backups........................................... 41
l Configuring backups of a stand-alone server..................................................... 43
l Configuring federated backups of a DAG........................................................... 50
l Configuring NetWorker privileges manually........................................................73
l Modifying a client resource after upgrading from NMM version 8.2.x or earlier

........................................................................................................................... 74
l Verifying a backup..............................................................................................75
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Planning Exchange Server backups
This section helps you plan an Exchange Server backup.

Backup considerations
Consider the following information when you perform Exchange Server backups:

l NMM does not support backing up Exchange Servers with disjoint name spaces.
The primary DNS suffix of the hosts must match the DNS domain name.

l In a stand-alone environment, schedule backups using the FQDN or hostname of
the NetWorker client computer.

l In a traditional DAG environment with an IP, schedule federated backups using the
DAG name.

l In an IP-less DAG environment, schedule federated backups using a physical
mailbox server in the DAG.

l You cannot interrupt or halt the Exchange backup process.
For example, in an Exchange backup, the nsrnmmsv.exe process on the
production server and the Eseutil process on the proxy resource might continue to
run after you stop the backup. If you try to stop the backup in the NMC, the
process might take a long time to complete.

l NMM backs up only mounted databases. If any databases are unmounted, NMM
does not display notifications during the backup operation and the backup
operation will be reported as successful. The NMM log files provide details about
unmounted databases.

Exchange backup prerequisites
Ensure that you meet the following prerequisites before you perform backup
procedures:

l Install the required .NET Framework version. The NetWorker Module for Microsoft
Release Notes provides more information about the required .NET Framework
version.

l Install the latest NMM hotfixes and cumulative updates.

l When configuring backup and recovery of a database availability group (DAG),
ensure that each DAG node uses the same version of Exchange Servers, Windows
Servers, and service packs or cumulative updates.

l Install the NetWorker client and NMM software on all Exchange Servers that you
want to backup.

l Ensure that the user who administers backup operations is assigned the required
privileges.

Circumstances that promote incremental or subsequent backups to level full
Incremental or subsequent backups promote to a level full block-based backup during
the following circumstances:

l When you perform federated backups of writer-level save sets.
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You can only perform incremental backups of database-level save sets. If you are
using NMM 9.x with a NetWorker 8.2.x server, set the schedule level to
incremental and enable the Force incremental option in the Group resource.

l When NMM cannot find a full backup for the database within the specified save
set.

l When you add a Mailbox database to an existing save set.

l When NMM detects gaps between the last backup and the current set of logs.
For example, there are gaps between the highest log number that is retrieved from
index and the lowest log number that is retrieved from the disk.

l When you change the database or the log path after the last full backup.

l When you reinstall NMM.

l When you restart the backup client (Exchange Server).

l When you expand the disk size where an Exchange mailbox database resides.

l When you move a database to a different Exchange server.

Roadmap for configuring Exchange Server backups
To perform an Exchange Server backup, complete the following tasks:

1. Configure the backup storage resources.

2. Review the Exchange Server backup options that are described in Backup
configuration options on page 42.

3. Configure a client resource for each client using either the Client Backup
Configuration wizard or the Client Properties dialog box.

4. Configure a data protection policy for scheduled backups, including a group,
policy, policy workflow, and backup action.

Note

If you are using NetWorker server 8.2.3 or later, configure a regular NetWorker
backup group instead of configuring a data protection policy. Do not enable the
Snapshot option.

5. Configure privileges as described in Configuring NetWorker privileges.

The NetWorker Module for Microsoft Administration Guide and the NetWorker
Administration Guide provide details on how to perform these tasks.

Supported backup devices
NMM uses Client Direct to back up Exchange Server data, which enables backups to
bypass the NetWorker storage node and send data directly to the backup device.

The Client Direct feature, also known as direct file access or DFA, reduces bandwidth
use and bottlenecks at the storage node, and it provides highly efficient transmission
of backup data.

The following backup devices are supported with Client Direct:

l Data Domain Boost (DD Boost) devices

l Advanced file type devices (AFTD)
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Note

NMM cannot back up Exchange Server data directly to tape. However, clones of
Exchange Server backups can be directed to tape .

If an NMM backup cannot use the Client Direct feature because of inadequate
permissions or inaccessibility to the target device, the backup uses the storage node
instead.

If an NMM backup cannot use Client Direct or the storage node, the backup fails.

Note

NMM does not support dedicated storage nodes in a DAG environment when you use
NMM 19.1 with a NetWorker 8.2.3 or 8.2.4 server. When you configure the storage
node in a DAG environment, in the Device properties dialog box, for the Dedicated
storage node option, select No. Refer to the "Configuring backups to use a remote
storage node in a DAG environment" section in the Exchange Server Backup
Operations chapter for information about how to use a remote storage node in a DAG
environment.

Backup configuration options
This section describes the backup configuration options for Exchange Server backups
based on the environment.

Back up only active databases on the server
You can back up all the active database copies that reside on an Exchange Server
mailbox server in a DAG environment. You can perform full and incremental backups.
Active node backups include stand-alone servers, public folder mailboxes (Exchange
Server 2013, 2016, and 2019), and public folder databases (Exchange Server 2010).

Back up only passive databases on the server
You can back up all the passive database copies that reside on an Exchange Server
mailbox server in a DAG environment. You can perform full and incremental backups,
including incremental backups of public folders. Passive node backups do not include
public folder mailboxes or public folder databases.

Back up both active and passive databases on the server
You can back up both active and passive databases on Exchange Server mailbox
servers in the DAG environment. You can perform both full and incremental backups.

Back up to a local storage node in a stand-alone environment
You can configure a client to direct its backups to the local storage node on the
physical host on which it resides. To configure a stand-alone client, type curphyhost
in the Storage Nodes attribute of the stand-alone client. This variable is not supported
for DAG environments. The NetWorker Cluster Integration Guide provides more
information about the curphyhost command.

Back up to a remote storage node in a DAG or stand-alone environment
You can perform Exchange Server database backups using a remote NetWorker
storage node. You can perform both full and incremental backups.
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Note

NMM does not support dedicated storage nodes in a DAG environment when you use
NMM 19.1 with a NetWorker 8.2.3 or 8.2.4 server. When you configure the storage
node in a DAG environment, in the Device properties dialog box, for the Dedicated
storage node option, select No. Refer to the "Configuring backups to use a remote
storage node in a DAG environment" section in the Exchange Server Backup
Operations chapter for information about how to use a remote storage node in a DAG
environment.

Configuring backups of a stand-alone server
You can configure a backup of a stand-alone server using either the Client Backup
Configuration wizard or the Client Properties window.

Configure a stand-alone server backup using the Client Backup Configuration
wizard

Before you begin

To use the Client Backup Configuration wizard, you must first install the NMM client
on the Exchange server and run the NMM Exchange administration configuration tool.

Note

If you are using a NetWorker 8.2.3 or 8.2.4 server with the NMM 19.1 client:

l Configure a regular NetWorker backup group. Do not enable the Snapshot option.

l For the Client Backup Configuration wizard to function properly, ensure that JRE
8 is installed on the system where the NetWorker Management Console (NMC) is
used. While the NMC for NetWorker 8.2.x is compiled with JRE 7, the NMM 19.1
Java plugin for NMC is compiled with JRE 8.

l If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x,
ensure that the Block based backup checkbox is cleared in the client resource. If
you do not clear this setting, incremental backups are promoted to level full.

l The procedure that creates a client resource when using NetWorker server 8.2.x
and later is different from the procedure that creates a client resource when using
NetWorker server 19.1. Follow the procedure provided in the NetWorker Module for
Microsoft for Exchange VSS User Guide version 8.2 SP1.

l Before you start the NMM 19.1 Client Backup Configuration wizard to modify a
client resource that was created with NMM 8.2.x, ensure that the Snapshot
attribute of the NetWorker group that this client resource belongs to is clear. If
the Snapshot attribute is selected, you cannot select the NetWorker group in the
wizard and you are prompted to create or select another group.

Procedure

1. Open the NetWorker Management Console (NMC) and launch the NetWorker
Administration UI.

2. In the left navigation pane of the Protection tab, right-click Clients and select
New Client Wizard.
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The following figure shows the initial view of the Client Backup Configuration
wizard.

Figure 7 Initial view of the Client Backup Configuration wizard

3. On the Specify Client Information page:

a. In the Client Name field, type one of the following:

l The FQDN of the NetWorker client computer

l The hostname of the NetWorker client computer

b. (Optional) In the Comment field, type a description of the client.

c. (Optional) In the Tag field, type one or more tags to identify this client
resource for the creation of dynamic client groups for data protection
policies. Place each entry on a separate line.

d. (Optional) In the Group field, select a group to assign the client resource to.

The group to which the client belongs determines the workflow that is used
to back up the client.

e. In the Type box, select Traditional.

f. Click Next.

4. On the Specify the Backup Configuration Type page, select Microsoft
Exchange Server, and then click Next.

5. On the Select the NetWorker Client Properties page, complete the following
steps.

a. Specify the client properties. The following list explains the properties:

l Priority—Enables you to control the order in which the NetWorker
server contacts clients for backup.
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l Parallelism—Specifies the maximum number of data streams that a
client can send simultaneously during a backup operation.

l Remote Access—Specifies a list of users who can access to perform
remote access operations.

l Data Domain Interface—Specifies the protocol to use if you send the
backup data to a Data Domain Device. Available selections are IP, Fiber
Channel, or Both.

l Block based backup (BBB)—Enables block-based backups for the host.
This option is selected by default. You cannot clear this option for
Exchange client resources.

l Client direct—Enables the client to connect directly to the backup
storage device instead of connecting to a NetWorker storage node. This
option is selected by default. You cannot clear this option for Exchange
client resources.

b. Click Next.

6. On the Select the Exchange Server Objects page, verify that the databases to
back up are selected, and then click Next.

By default, all databases are selected for the entire server backup. Clear the
checkbox for any items that must be excluded from the backup.

7. The Specify Federated Exchange Backup Options page appears. In the
Consistency Check Options group, enable consistency checks by selecting
Perform a consistency check during backup and configure the following
settings:

a. To validate Exchange databases and logs, databases only, or logs only, select
Perform database consistency check during backup.

In a stand-alone environment, this option is selected by default.

b. To validate the Exchange files sequentially instead of in parallel, select
Sequential consistency check.

c. To manage the performance of the Consistency Check operation, select
Throttle Consistency Check, and then select Throttle I/O Operations and
Throttle Duration.

You can configure the number of consistency check I/O operations in each
cycle and the length of the pause between I/O operation cycles.

8. On the Client Configuration Summary page, review the details and perform
one of the following actions:

l Click Back to revisit the previous pages.

l Click Create to configure the client resources.

9. On the Check Results page, review the output of the Client Backup
Configuration wizard, and click Finish.

Results

The client resource appears in the Clients window pane.
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Configure a stand-alone server backup using the Client Properties window
This section describes how to configure a client resource for a stand-alone server
using the Client Properties window in the NMC.

Note

The procedure that creates a client resource when using NetWorker server 8.2.x is
different from the procedure that creates a client resource when using NetWorker
server 19.1. Follow the procedure provided in the NetWorker Module for Microsoft for
Exchange VSS User Guide version 8.2 SP1. Keep the following considerations in mind
when following the NMM 8.2 SP1 procedure:

l Configure a regular NetWorker backup group instead of configuring a data
protection policy. Do not enable the Snapshot option.

l If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x,
ensure that the Block based backup checkbox is cleared in the client resource. If
you do not clear this setting, incremental backups are promoted to level full.

l In the Client Properties window, on the Apps & Modules tab, in the Backup
Command field, type nsrnmmsv.exe.

Procedure

1. In the Administration view of the NetWorker Management Console (NMC),
click Protection.

2. In the expanded left pane, select Clients.

3. From the File menu, select New.

4. On the General tab:

a. In the Name field, type one of the following values:

l The FQDN of the NetWorker client computer

l The hostname of the NetWorker client computer

b. In the Comment field, type a description.

c. Ensure that Block based backup is selected.

d. Determine a list of save sets that must be included in the backup.

To display a list of the application data save sets that are available for
backup, open a command prompt on the Exchange server and type the
following command.

Note

Before using this command, use the NMM Exchange administrator
configuration tool to create an NMM Exchange administrator account.

nsrnmmsv -P
The following is an example output:

“APPLICATIONS:\Microsoft Exchange 2010”
“APPLICATIONS:\Microsoft Exchange 2010\DB1”
“APPLICATIONS:\Microsoft Exchange 2010\DB2”
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“APPLICATIONS:\Microsoft Exchange 2010\DB3”
“APPLICATIONS:\Microsoft Exchange 2010\DB4”
“APPLICATIONS:\Microsoft Exchange 2010\DB5”
The output contains all databases in the DAG. The -v option is not
supported for DAGs. Each line of output corresponds to a save set entry
that you can add to the save set attribute of a client resource. Type each
entry on a separate line.

Note

Remove the quotation marks when copying the save set name from the
output.

e. In the Save Set field, specify the components to be backed up.

The following table provides the Exchange Server 2010 save set syntax for
application data.

Table 8 Exchange Server 2010 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2010

Database name level APPLICATIONS:\Microsoft
Exchange 2010\<Database name>

The following table provides the Exchange Server 2013 save set syntax for
application data.

Table 9 Exchange Server 2013 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2013

Database name level APPLICATIONS:\Microsoft
Exchange 2013\<Database name>

The following table provides the Exchange Server 2016 save set syntax for
application data.

Table 10 Exchange Server 2016 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2016

Database name level APPLICATIONS:\Microsoft
Exchange 2016\<Database name>

The following table provides the Exchange Server 2019 save set syntax for
application data.
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Table 11 Exchange Server 2019 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2019

Database name level APPLICATIONS:\Microsoft
Exchange 2019\<Database name>

When you specify save set names in the Save Set field of the client
resource, you must specify some special characters, such as the backward
slash (\), by their URL-encoded values.

The following table lists the most commonly used special characters and
their URL values.

Table 12 Special characters and their URL-encoded values

Special
character

URL-encoded
value

Special
character

URL-encoded
value

\ %5C ? %3F

/ %2F ] %5D

" %22 [ %5B

% %25 } %7D

# %23 { %7B

& %26 ^ %5E

< %3C ‘ %60

> %3E | %7C

f. In the Protection group list field, select the appropriate option.

5. Click the Apps & Modules tab and do the following:

a. In the Access area, leave the Remote user and Password fields empty.

b. In the Backup command field, type the backup command:

nsrnmmsv.exe

c. In the Application Information field, type the required variables and values.
If you specify more than one Exchange Application Information attribute at a
time, type each attribute name and its value on a separate line.

The following table provides the Exchange Application Information attribute
names and valid values.

Table 13 Exchange Application Information attribute names and valid values

Attribute name Description Default and valid values

NSR_EXCH_CHECK
=value

Optional. Specifies
if a consistency
check should be
run for databases.

l Yes—Runs a consistency check.

This is the default value for
Exchange Server stand-alone
backups.
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Table 13 Exchange Application Information attribute names and valid
values (continued)

Attribute name Description Default and valid values

l No—Does not run a consistency

check.

If the value is no, NMM indicates that

the consistency check is omitted from
the backup log.

NSR_EXCH_BACKU
P=active/
passive/
preferred/all

Optional. Specifies
whether to back up
active, passive,
preferred, or all of
the database
copies.

l Preferred (default)—Backs up only a
passive copy or replica of each
database. If no passive database
exists, the active database is backed
up.

l Active—Backs up only active
database copies.

l Passive—Backs up only passive
database copies.

l All—Backs up both active and
passive databases.

NSR_EXCLUDE_CO
MPONENTS=db1,d
b2…

Optional. Excludes
specified
databases from
backup

l Undefined (default).

l To exclude databases from the
backup, type a comma-separated list
of their names.

The following list items are examples of application variables:

l NSR_EXCH_BACKUP=<active/passive/preferred/all>
l NSR_EXCH_CHECK=<yes/no>
l NSR_EXCLUDE_COMPONENTS=<mydb1,mydb2,mydb3>

6. Ensure that Client Direct is enabled.

Exchange backups require Client Direct.

7. Click the Globals (1 of 2) tab and verify that the Aliases attribute displays the
NETBIOS name for the client.

This name is filled in automatically.

The NMM client uses the host computer NETBIOS or “short” name when it
connects to the NetWorker server to browse backups. If the NETBIOS name is
not found, NMM does not display backups.

8. If you are using a NetWorker storage node that is different from the NetWorker
server, when you configure a client resource for the Exchange Server, click the
Globals (2 of 2) tab, and in the Storage node name field, type the storage
node name.

9. Click OK.

Results

The client resource appears in the Clients window pane of NMC.
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Configuring federated backups of a DAG
This section describes how to configure and perform federated database availability
group (DAG) backups.

NMM supports backup configurations of IP DAG (with an administrative access point)
and IP-less DAG (with no administrative access point).

Performing backups in a DAG environment
In a highly available database availability group (DAG) environment, schedule
federated backups by using the DAG name as the client instance. In the case of an IP-
less DAG, use the physical cluster node (DAG node) as the client instance.

To back up an IP-less DAG, use a physical mailbox server in the DAG to configure a
client resource, then add the DAG short name and FQDN as an alias to the client
resource. Use this client to schedule federated backups of the IP-less DAG.

When backing up active or passive database copies in the Exchange DAG
environment, all DAGs use the federated backup method to best handle fail over
scenarios. The federated backup method provides the following benefits:

l It allows backups of passive database copies to continue even when the passive
database copies move among Exchange servers.

l It enables you to back up all DAG members, including stand-alone and public folder
mailbox databases, with a single save set without running a separate backup of
each node. Each Exchange server for which a backup job is sent performs its
backups in parallel with the other Exchange servers, which results in faster
backups.

Preferred server order list
When you perform a backup through the DAG resource with the NSR_EXCH_BACKUP
attribute set to Passive or Preferred, NMM selects an Exchange server to back up
the passive copies of the databases. Because multiple Exchange servers can host
replicas or passive copies of the same database, you can specify a preferred server
order list (PSOL) to tell NMM which Exchange servers to use to back up the
Exchange databases. When the backup starts, NMM backs up the passive or replica
copies of each database from the Exchange Servers that are listed in the PSOL
parameter. You create the PSOL parameter in the Client Configuration wizard, and the
PSOL parameter is associated with a single DAG client resource.

If stand-alone databases (including public folder databases or public folder mailboxes)
reside in the DAG, the coordinating node determines whether they exist on that server
and, if they do, adds them to the save set list. The coordinating node then goes to
another server in the list and repeats the check for passive and stand-alone databases.
During this process, the node omits databases that are already listed.

Once the coordinating node has gone through the list of servers, it validates that no
databases within the DAG have been left out of the list of save sets. After the
coordinating node starts the backup on each of the identified servers.

If you want to exclude stand-alone databases (including public folder databases or
public folder mailboxes) from the backup, you must set the NSR_EXCH_INCL_SA
attribute value to false.
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Configuring federated backups of a DAG with an IP
You can configure backups of a database availability group (DAG) with an IP
(administrative access point) using the Client Backup Configuration wizard or through
the Client Properties window.

Before you begin

Verify that the NetWorker client resources for the physical DAG nodes are not part of
a backup group outside of the DAG.

Configure a federated backup of a DAG with an IP using the Client Backup Configuration wizard
This section describes configuring a client resource for a database availability group
(DAG) with an IP using the Client Backup Configuration wizard.

Before you begin

To use the Client Backup Configuration wizard, you must first install the NMM client
on the Exchange server and run the NMM Exchange administration configuration tool.

Note

If you are using a NetWorker 8.2.3 or 8.2.4 server with the NMM 19.1 client:

l Configure a regular NetWorker backup group. Do not enable the Snapshot option.

l For the Client Backup Configuration wizard to function properly, ensure that JRE
8 is installed on the system where the NetWorker Management Console (NMC) is
used. While the NMC for NetWorker 8.2.x is compiled with JRE 7, the NMM 19.1
Java plugin for NMC is compiled with JRE 8.

l If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x,
ensure that the Block based backup checkbox is cleared in the client resource. If
you do not clear this setting, incremental backups are promoted to level full.

l The procedure that creates a client resource when using NetWorker server 8.2.x
and later is different from the procedure that creates a client resource when using
NetWorker server 19.1. Follow the procedure provided in the NetWorker Module for
Microsoft for Exchange VSS User Guide version 8.2 SP1.

l Before you start the NMM 19.1 Client Backup Configuration wizard to modify a
client resource that was created with NMM 8.2.x, ensure that the Snapshot
attribute of the NetWorker group that this client resource belongs to is clear. If
the Snapshot attribute is selected, you cannot select the NetWorker group in the
wizard and you are prompted to create or select another group.

Procedure

1. Open the NetWorker Management Console (NMC) and launch the NetWorker
Administration UI.

2. In the left navigation pane of the Protection tab, right-click Clients and select
New Client Wizard.

The following figure shows the initial view of the Client Backup Configuration
wizard.
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Figure 8 Initial view of the Client Backup Configuration wizard

3. On the Specify Client Information page:

a. In the Client Name field, type the DAG name.

Note

Do not type the IP address as the client name.

b. (Optional) In the Comment field, type a description of the client.

c. (Optional) In the Tag field, type one or more tags to identify this client
resource for the creation of dynamic client groups for data protection
policies. Type each entry on a separate line.

d. In the Group field, select a group to assign the client resource to.

The group to which the client belongs determines the workflow that is used
to back up the client.

e. In the Type box, select Traditional.

f. Click Next.

4. On the Specify the Backup Configuration Type page, select Microsoft
Exchange Server, and then click Next.

5. On the Select the NetWorker Client Properties page, complete the following
steps.

a. Specify the client properties. The following list explains the properties:

l Priority—Enables you to control the order in which the NetWorker
server contacts clients for backup.
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l Parallelism—Specifies the maximum number of data streams that a
client can send simultaneously during a backup operation.

l Remote Access—Specifies a list of users who can access to perform
remote access operations.

l Data Domain Interface—Specifies the protocol to use if you send the
backup data to a Data Domain Device. Available selections are IP, Fiber
Channel, or Both.

l Block based backup (BBB)—Enables block-based backups for the host.
This option is selected by default. You cannot clear this option for
Exchange client resources.

l Client direct—Enables the client to connect directly to the backup
storage device instead of connecting to a NetWorker storage node. This
option is selected by default. You cannot clear this option for Exchange
client resources.

b. Click Next.

6. On the Select the Exchange Server Objects page, verify that the databases to
back up are selected, and then click Next.

By default, all databases are selected for the entire server backup. Clear the
checkbox for any items that must be excluded from the backup.

7. On the Specify Federated Exchange Backup Options page:

a. For federated backup client backup configurations, in the Database Backup
Options group, select one of the following:

l Preferred Passive Backup to back up passive or replica copies of the
databases.
If no replica copy is available or healthy for the database, the active copy
is backed up.

l Passive Only Backup to back up only passive copies or replicas of
databases.

l Active Only Backup to back up only active copies of databases.

l Use Exclude Component List to select which databases to exclude from
the backup.

Note

When you select Active Backup or Passive Backup, the backup fails if the
selected type of database does not exist.
The Database Backup Options box is not displayed for Exchange stand-
alone servers. 

b. For federated backup client backup configurations, in the Federated
Options group:

a. Select Use Preferred Server Order List to specify the order in which to
back up servers.
By default, the Use Preferred Server Order List is selected.

b. Select a server from the Available Servers list, and then click the right
arrow to move it to the Preferred Server List.
To adjust the order of servers:
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a. Select a server in the Preferred Server List.

b. Click the up and down arrows to change the order.

c. Select Include Standalone and Public Folder databases to back up
stand-alone databases and public folder mailboxes (Exchange Server
2013, 2016, and 2019), or public folder databases (Exchange Server
2010).
By default, the Include Standalone and Public Folder checkbox is
selected.

Note

The Include Standalone and Public Folder option is supported only for
federated DAG backup configurations.

c. In the Consistency Check Options group, enable consistency checks by
selecting the Perform a consistency check during backup option.
Configure the following settings:

a. Select the Perform database consistency check during backup option
to validate Exchange databases and logs, databases only, or logs only.
In a stand-alone environment, the Perform database consistency check
during backup option is selected by default. In a DAG environment,
performing the database consistency check is optional.

b. Select the Sequential consistency check option to validate the
Exchange files sequentially instead of in parallel.

c. Select the Throttle Consistency Check option and then choose the
Throttle I/O Operations and Time to Pause Between I/O Operations
options to manage the performance of the Consistency Check operation.
You can configure the number of consistency check I/O operations to
perform before pausing and the length of time to pause between I/O
operation cycles.

d. Click Next.

8. On the Client Configuration Summary page, review the details and perform
one of the following actions:

l Click Back to revisit the previous pages.

l Click Create to configure the client resources.

9. On the Check Results page, review the output of the Client Backup
Configuration wizard, and click Finish.

Results

The client resource appears in the Clients window pane.
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Configure a federated backup of a DAG with an IP by using the Client Properties window
This section describes configuring a client resource for a database availability group
(DAG) with an IP by using the Client Properties window in the NetWorker
Management Console (NMC).

Note

The procedure that creates a client resource when using NetWorker server 8.2.x is
different from the procedure that creates a client resource when using NetWorker
server 19.1. Follow the procedure provided in the NetWorker Module for Microsoft for
Exchange VSS User Guide version 8.2 SP1. Keep the following considerations in mind
when following the NMM 8.2 SP1 procedure:

l Configure a regular NetWorker backup group instead of configuring a data
protection policy. Do not enable the Snapshot option.

l If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x,
ensure that the Block based backup checkbox is cleared in the client resource. If
you do not clear this setting, incremental backups are promoted to level full.

l In the Client Properties window, on the Apps & Modules tab, in the Backup
Command field, type nsrnmmsv.exe.

Procedure

1. In the Administration view of the NetWorker Management Console (NMC),
click Protection.

2. In the expanded left pane, select Clients.

3. From the File menu, select New.

4. On the General tab:

a. In the Name field, type the DAG name.

Note

Do not type the IP address as the client name.

b. (Optional) In the Comment field, type a description.

c. Ensure that Block based backup is selected.

d. Determine a list of save sets that must be included in the backup.

To display a list of the application data save sets that are available for
backup, open a command prompt on the Exchange server and type the
following command.

Note

Before using the following command, use the NMM Exchange administrator
configuration tool to create an NMM Exchange administrator account.

At the command prompt, type the following on any node in the DAG:

nsrnmmsv -A NSR_FEDERATED_BACKUP=yes -A NSR_EXCH_DAG=<DAG
client> -P
The following is example output:
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“APPLICATIONS:\Microsoft Exchange 2010”
“APPLICATIONS:\Microsoft Exchange 2010\DB1”
“APPLICATIONS:\Microsoft Exchange 2010\DB2”
“APPLICATIONS:\Microsoft Exchange 2010\DB3”
“APPLICATIONS:\Microsoft Exchange 2010\DB4”
“APPLICATIONS:\Microsoft Exchange 2010\DB5”
The output contains all databases in the DAG. The -v option is not
supported for DAGs. Each line of output corresponds to a save set entry
that you can add to the save set attribute of a client resource. Type each
entry on a separate line.

Note

Remove the quotation marks when copying the save set name from the
output.

e. In the Save Set field, specify the components to be backed up.

The following table provides the Exchange Server 2010 save set syntax for
application data.

Table 14 Exchange Server 2010 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2010

Database name level APPLICATIONS:\Microsoft
Exchange 2010\<Database name>

The following table provides the Exchange Server 2013 save set syntax for
application data.

Table 15 Exchange Server 2013 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2013

Database name level APPLICATIONS:\Microsoft
Exchange 2013\<Database name>

The following table provides the Exchange Server 2016 save set syntax for
application data.

Table 16 Exchange Server 2016 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2016

Database name level APPLICATIONS:\Microsoft
Exchange 2016\<Database name>

The following table provides the Exchange Server 2019 save set syntax for
application data.
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Table 17 Exchange Server 2019 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2019

Database name level APPLICATIONS:\Microsoft
Exchange 2019\<Database name>

When specifying save set names in the Save Set field of the client resource,
you must specify some special characters, such as the backward slash (\),
by their URL-encoded values.

The following table lists the most commonly used special characters and
their URL values.

Table 18 Special characters and their URL-encoded values

Special
character

URL-encoded
value

Special
character

URL-encoded
value

\ %5C ? %3F

/ %2F ] %5D

" %22 [ %5B

% %25 } %7D

# %23 { %7B

& %26 ^ %5E

< %3C ‘ %60

> %3E | %7C

f. In the Protection group list field, select the appropriate option.

5. Click the Apps & Modules tab and do the following:

a. In the Access area, leave the Remote user and Password fields empty.

b. In the Backup command field, type the backup command:

nsrnmmsv.exe

c. In the Application Information field, type the required variables and values.
If you specify more than one application attribute at a time, type each entry
and its value on a separate line.

The following table provides the application variables and values for the
Exchange Server environment.

Table 19 Exchange Application Information attribute settings

Attribute name Description Default and valid values

NSR_FEDERATED_
BACKUP=<yes/no
>

Specifies that the
backup is
federated.

l No (default)—The backup is non-

federated.

l Yes—The backup is federated.
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Table 19 Exchange Application Information attribute settings (continued)

Attribute name Description Default and valid values

Note

Only federated backups are supported
for Exchange Server DAGs.

NSR_EXCH_DAG=<
DAG_Instance_N
ame>

Specifies the DAG
name for a backup
in a DAG
environment.

l Undefined (default).

l FQDN of the DAG.

For example,
NSR_EXCH_DAG=mydag.domainna
me.com

NSR_EXCH_CHECK
=<yes/no>

Optional. Specifies
if a consistency
check should be
run for databases.

l Yes—Runs a consistency check.

This is the default value for
Exchange Server stand-alone
backups.

l No—Does not run a consistency

check.

If the value is no, NMM indicates that

the consistency check is omitted from
the backup log.

NSR_EXCH_BACKU
P=active/
passive/
preferred/all

Optional. Specifies
whether to back up
active, passive,
preferred, or all of
the database
copies.

l Preferred (default)—Backs up only a
passive copy or replica of each
database. If no passive database
exists, the active database is backed
up.

l Active—Backs up only active
database copies.

l Passive—Backs up only passive
database copies.

l All—Backs up both active and
passive databases.

NSR_EXCLUDE_CO
MPONENTS=db1,d
b2…

Optional. Excludes
specified
databases from
backup

l Undefined (default).

l To exclude databases from the
backup, type a comma-separated list
of their names.

NSR_EXCH_INCL_
SA=<TRUE/
FALSE>

Optional. Includes
stand-alone
databases, public
folder mailboxes
(Exchange Server
2013, 2016, and
2019), or public
folder databases
(Exchange Server

l True (default)—Includes stand-

alone databases and public folder
mailboxes in the backup.

l False—Excludes stand-alone

databases and public folder
mailboxes from the backup.
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Table 19 Exchange Application Information attribute settings (continued)

Attribute name Description Default and valid values

2010) in the
backup.

NSR_FEDERATED_
PSOL=<DAG
Node1>,<DAG
node2>...

Optional. Specifies
the order in which
to back up the
databases on each
server in the DAG.

l Undefined (default)—The
coordinating node distributes the
backups based on an unordered list
of Exchange servers in the DAG.

l Defined—To define a list, type a
comma-separated list of the order in
which to back up the databases on
each server in the DAG.

NSR_USE_CLIENT
_SN_LIST=<yes/
no>

Optional. Specifies
to back up each
mailbox server in
the DAG to a
specific storage
node, based on
what is specified in

the Storage
Node attribute of
each mailbox
server client
resource.

l No (default)—The storage node is

assigned according to the backup
policy.

l Yes—The client resource for the

mailbox server where the secondary
NMM backup process runs provides
the storage node that should be
used.

6. Ensure that Client Direct is enabled.

Exchange backups require Client Direct.

7. Click the Globals (1 of 2) tab and verify that the Aliases attribute displays the
NETBIOS name for the client.

This name is filled in automatically.

The NMM client uses the host computer NETBIOS or “short” name when it
connects to the NetWorker server to browse backups. If the NETBIOS name is
not found, NMM does not display backups.

8. If you are using a NetWorker storage node that is different from the NetWorker
server, when you configure a client resource for the Exchange Server, click the
Globals (2 of 2) tab, and in the Storage node name field, type the storage
node name.

9. Click OK.

10. Create additional client resources for each physical mailbox server in the DAG:

a. In the Administration view of the NMC, click Protection.

b. In the expanded left pane, select Clients.

c. From the File menu, select New.

d. In the Name field, type the Exchange server name or FQDN.

e. In the Comment field, type a description.

Use this attribute to differentiate the purpose of the resource for each
mailbox server.
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f. In the Retention Policy field, select a retention policy from the list.

g. Confirm that Scheduled Backups is selected.

h. In the Save Set field, specify the components that are to be backed up.

Configuring federated backups of an IP-less DAG
You can configure backups of an IP-less DAG (with no administrative access point)
using the Client Backup Configuration wizard or by using the Client Properties
window.

Consider the following before configuring a backup of an IP-less DAG:

l Exchange 2013 SP1 and later supports IP-less DAG.

l Exchange 2016 and 2019 defaults to IP-less DAG.

l IP-less DAG requires Windows Server 2012 R2 or later.

l An existing DAG (IP-based) cannot be converted to an IP-less DAG.

Configure a federated backup of an IP-less DAG using the Client Backup Configuration wizard
This section describes configuring a client resource for an IP-less database availability
group (DAG) by using the Client Backup Configuration wizard.

Note

For stand-alone databases that are part of an IP-less DAG, use the Client Properties
window to configure the backup. You cannot use the Client Backup Configuration
wizard to configure stand-alone databases in an IP-less DAG.

To use the Client Backup Configuration wizard, first install the NMM client on the
Exchange server, and then run the NMM Exchange Admin Configuration tool.

Note

If you are using a NetWorker 8.2.3 or 8.2.4 server with the NMM 19.1 client:

l Configure a regular NetWorker backup group. Do not enable the Snapshot option.

l For the Client Backup Configuration wizard to function properly, ensure that JRE
8 is installed on the system where the NetWorker Management Console (NMC) is
used. While the NMC for NetWorker 8.2.x is compiled with JRE 7, the NMM 19.1
Java plugin for NMC is compiled with JRE 8.

l If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x,
ensure that the Block based backup checkbox is cleared in the client resource. If
you do not clear this setting, incremental backups are promoted to level full.

l The procedure that creates a client resource when using NetWorker server 8.2.x
and later is different from the procedure that creates a client resource when using
NetWorker server 19.1. Follow the procedure provided in the NetWorker Module for
Microsoft for Exchange VSS User Guide version 8.2 SP1.

l Before you start the NMM 19.1 Client Backup Configuration wizard to modify a
client resource that was created with NMM 8.2.x, ensure that the Snapshot
attribute of the NetWorker group that this client resource belongs to is clear. If
the Snapshot attribute is selected, you cannot select the NetWorker group in the
wizard and you are prompted to create or select another group.
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Procedure

1. Open the NetWorker Management Console (NMC) and launch the NetWorker
Administration UI.

2. In the left navigation pane of the Protection tab, right-click Clients and select
New Client Wizard.

The following figure shows the initial view of the Client Backup Configuration
wizard.

Figure 9 Initial view of the Client Backup Configuration wizard

3. On the Specify Client Information page:

a. In the Client Name field, type the hostname or fully qualified domain name
(FQDN) of a physical server node in the DAG that will be used as the access
point.

Note

Do not type the IP address as the client name.

b. (Optional) In the Comment field, type a description of the client.

c. (Optionally) In the Tag field, type one or more tags to identify this client
resource for the creation of dynamic client groups for data protection
policies. Type each entry on a separate line.

d. (Optional) In the Group field, select a group to assign the client resource to.

The group to which the client belongs determines the workflow that is used
to back up the client.

e. In the Type box, select Traditional.
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f. Click Next.

4. On the Specify the Backup Configuration Type page, select Microsoft
Exchange Server, and then click Next.

5. On the Select the NetWorker Client Properties page, complete the following
steps.

a. Specify the client properties. The following list explains the properties:

l Priority—Enables you to control the order in which the NetWorker
server contacts clients for backup.

l Parallelism—Specifies the maximum number of data streams that a
client can send simultaneously during a backup operation.

l Remote Access—Specifies a list of users who can access to perform
remote access operations.

l Data Domain Interface—Specifies the protocol to use if you send the
backup data to a Data Domain Device. Available selections are IP, Fiber
Channel, or Both.

l Block based backup (BBB)—Enables block-based backups for the host.
This option is selected by default. You cannot clear this option for
Exchange client resources.

l Client direct—Enables the client to connect directly to the backup
storage device instead of connecting to a NetWorker storage node. This
option is selected by default. You cannot clear this option for Exchange
client resources.

b. Click Next.

6. On the Select the Exchange Server Objects page, verify that the databases to
back up are selected, and then click Next.

By default, all databases are selected for the entire server backup. Clear the
checkbox for any items that must be excluded from the backup.

7. On the Specify Federated Exchange Backup Options page:

a. For federated backup client backup configurations, in the Database Backup
Options group, select one of the following:

l Preferred Passive Backup to back up passive or replica copies of the
databases.
If no replica copy is available or healthy for the database, the active copy
is backed up.

l Passive Only Backup to back up only passive copies or replicas of
databases.

l Active Only Backup to back up only active copies of databases.

l Use Exclude Component List to select which databases to exclude from
the backup.

Note

When you select Active Backup or Passive Backup, the backup fails if the
selected type of database does not exist.
The Database Backup Options box is not displayed for Exchange stand-
alone servers. 
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b. For federated backup client backup configurations, in the Federated
Options group:

a. Select Use Preferred Server Order List to specify the order in which to
back up servers.
By default, the Use Preferred Server Order List is selected.

b. Select a server from the Available Servers list, and then click the right
arrow to move it to the Preferred Server List.
To adjust the order of servers:

a. Select a server in the Preferred Server List.

b. Click the up and down arrows to change the order.

c. Select Include Standalone and Public Folder databases to back up
stand-alone databases and public folder mailboxes (Exchange Server
2013, 2016, and 2019), or public folder databases (Exchange Server
2010).
By default, the Include Standalone and Public Folder checkbox is
selected.

Note

The Include Standalone and Public Folder option is supported only for
federated DAG backup configurations.

c. In the Consistency Check Options group, enable consistency checks by
selecting the Perform a consistency check during backup option.
Configure the following settings:

a. Select the Perform database consistency check during backup option
to validate Exchange databases and logs, databases only, or logs only.
In a stand-alone environment, the Perform database consistency check
during backup option is selected by default. In a DAG environment,
performing the database consistency check is optional.

b. Select the Sequential consistency check option to validate the
Exchange files sequentially instead of in parallel.

c. Select the Throttle Consistency Check option and then choose the
Throttle I/O Operations and Time to Pause Between I/O Operations
options to manage the performance of the Consistency Check operation.
You can configure the number of consistency check I/O operations to
perform before pausing and the length of time to pause between I/O
operation cycles.

d. Click Next.

8. On the Client Configuration Summary page, review the details and perform
one of the following actions:

l Click Back to revisit the previous pages.

l Click Create to configure the client resources.

9. On the Check Results page, review the output of the Client Backup
Configuration wizard, and click Finish.

10. In the NMC, click the Protection tab on the Administration window.

11. Locate the newly created client in the navigation tree or right-click the client in
the Clients table, and open the Client Properties window.

12. On the Globals (1 of 2) tab, in the Aliases field, type the DAG name.

Exchange Server Backup Operations

Configuring federated backups of an IP-less DAG     63



Include both the short name and full name of the DAG. For example, if
buexch13.net is the domain name and DAG2 is the DAG name, type both DAG2
and DAG2.buexch13.net.

The following figure illustrates adding the DAG name as an alias to a client
resource.

Figure 10 Adding the DAG name as an alias to a client resource

This step ensures that NetWorker recognizes that the IP-less DAG name is an
alias of the chosen physical mailbox server.

Note

After the DAG name is added as an alias to a client, do not remove the alias or
add the DAG name to another client resource. If the DAG node that is
configured as the client resource is unavailable and you must configure a new
client, you are not required to add the DAG name as an alias to the new client.

13. To close the Client Properties window, click OK.

14. Assign the client resource to a backup group.

Results

You can use the client resource to perform federated backups of the IP-less DAG.
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Configure a federated backup of an IP-less DAG using the Client Properties window
This section describes configuring a client resource for an IP-less database availability
group (DAG) by using the Client Properties window in the NetWorker Management
Console (NMC).

Note

The procedure that creates a client resource when using NetWorker server 8.2.x is
different from the procedure that creates a client resource when using NetWorker
server 19.1. Follow the procedure provided in the NetWorker Module for Microsoft for
Exchange VSS User Guide version 8.2 SP1. Keep the following considerations in mind
when following the NMM 8.2 SP1 procedure:

l Configure a regular NetWorker backup group instead of configuring a data
protection policy. Do not enable the Snapshot option.

l If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x,
ensure that the Block based backup checkbox is cleared in the client resource. If
you do not clear this setting, incremental backups are promoted to level full.

l In the Client Properties window, on the Apps & Modules tab, in the Backup
Command field, type nsrnmmsv.exe.

Procedure

1. In the Administration view of the NetWorker Management Console (NMC),
click Protection.

2. In the expanded left pane, select Clients.

3. From the File menu, select New.

4. In the General tab:

a. In the Name field, type the FQDN or hostname of a physical server node in
the DAG that will be used as the access point.

Note

Do not type the IP address as the client name.

b. In the Comment field, type a description.

c. Ensure that Block based backup is selected.

d. Determine a list of save sets that must be included in the backup.

To display a list of the application data save sets that are available for
backup, open a command prompt on the Exchange server and type the
following command. Before using the following command, use the NMM
Exchange administrator configuration tool to create an NMM Exchange
administrator account.

At the command prompt, type the following on any node in the DAG:

nsrnmmsv -A NSR_FEDERATED_BACKUP=yes -A NSR_EXCH_DAG=<DAG
client> -P
The following is example output:

“APPLICATIONS:\Microsoft Exchange 2010”
“APPLICATIONS:\Microsoft Exchange 2010\DB1”
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“APPLICATIONS:\Microsoft Exchange 2010\DB2”
“APPLICATIONS:\Microsoft Exchange 2010\DB3”
“APPLICATIONS:\Microsoft Exchange 2010\DB4”
“APPLICATIONS:\Microsoft Exchange 2010\DB5”
The output contains all databases in the DAG. The -v option is not
supported for DAGs. Each line of output corresponds to a save set entry
that you can add to the save set attribute of a client resource. Type each
entry on a separate line.

Note

Remove the quotation marks when copying the save set name from the
output.

e. In the Save Set field, specify the components to be backed up.

The following table provides the Exchange Server 2010 save set syntax for
application data.

Table 20 Exchange Server 2010 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2010

Database name level APPLICATIONS:\Microsoft
Exchange 2010\<Database name>

The following table provides the Exchange Server 2013 save set syntax for
application data.

Table 21 Exchange Server 2013 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2013

Database name level APPLICATIONS:\Microsoft
Exchange 2013\<Database name>

The following table provides the Exchange Server 2016 save set syntax for
application data.

Table 22 Exchange Server 2016 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2016

Database name level APPLICATIONS:\Microsoft
Exchange 2016\<Database name>

The following table provides the Exchange Server 2019 save set syntax for
application data.
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Table 23 Exchange Server 2019 save set syntax

Type of backup data Save set syntax

Writer level APPLICATIONS:\Microsoft
Exchange 2019

Database name level APPLICATIONS:\Microsoft
Exchange 2019\<Database name>

When specifying save set names in the Save Set field of the client resource,
you must specify some special characters, such as the backward slash (\),
by their URL-encoded values.

The following table lists the most commonly used special characters and
their URL values.

Table 24 Special characters and their URL-encoded values

Special
character

URL-encoded
value

Special
character

URL-encoded
value

\ %5C ? %3F

/ %2F ] %5D

" %22 [ %5B

% %25 } %7D

# %23 { %7B

& %26 ^ %5E

< %3C ‘ %60

> %3E | %7C

f. Select the appropriate option in the Protection group list field.

5. Click the Apps & Modules tab and do the following:

a. In the Access area, leave the Remote user and Password fields empty.

b. In the Backup command field, type the backup command:

nsrnmmsv.exe

c. In the Application Information field, type the required variables and values.
If you specify more than one Exchange attribute at a time, type each entry
and its value on a separate line.

The following table provides the application variables and values for the
Exchange Server environment.

Table 25 Exchange Application Information attribute settings

Attribute name Description Default and valid values

NSR_FEDERATED_
BACKUP=<yes/no
>

Specifies that the
backup is
federated.

l No (default)—The backup is non-

federated.

l Yes—The backup is federated.
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Table 25 Exchange Application Information attribute settings (continued)

Attribute name Description Default and valid values

Note

Only federated backups are supported
for Exchange Server DAGs.

NSR_EXCH_DAG=<
DAG_Instance_N
ame>

Specifies the DAG
name for a backup
in a DAG
environment.

l Undefined (default).

l FQDN of the DAG.

For example,
NSR_EXCH_DAG=mydag.domainna
me.com

NSR_EXCH_CHECK
=<yes/no>

Optional. Specifies
if a consistency
check should be
run for databases.

l Yes—Runs a consistency check.

This is the default value for
Exchange Server stand-alone
backups.

l No—Does not run a consistency

check.

If the value is no, NMM indicates that

the consistency check is omitted from
the backup log.

NSR_EXCH_BACKU
P=active/
passive/
preferred/all

Optional. Specifies
whether to back up
active, passive,
preferred, or all of
the database
copies.

l Preferred (default)—Backs up only a
passive copy or replica of each
database. If no passive database
exists, the active database is backed
up.

l Active—Backs up only active
database copies.

l Passive—Backs up only passive
database copies.

l All—Backs up both active and
passive databases.

NSR_EXCLUDE_CO
MPONENTS=db1,d
b2…

Optional. Excludes
specified
databases from
backup

l Undefined (default).

l To exclude databases from the
backup, type a comma-separated list
of their names.

NSR_EXCH_INCL_
SA=<TRUE/
FALSE>

Optional. Includes
stand-alone
databases, public
folder mailboxes
(Exchange Server
2013, 2016, and
2019), or public
folder databases
(Exchange Server

l True (default)—Includes stand-

alone databases and public folder
mailboxes in the backup.

l False—Excludes stand-alone

databases and public folder
mailboxes from the backup.
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Table 25 Exchange Application Information attribute settings (continued)

Attribute name Description Default and valid values

2010) in the
backup.

NSR_FEDERATED_
PSOL=<DAG
Node1>,<DAG
node2>...

Optional. Specifies
the order in which
to back up the
databases on each
server in the DAG.

l Undefined (default)—The
coordinating node distributes the
backups based on an unordered list
of Exchange servers in the DAG.

l Defined—To define a list, type a
comma-separated list of the order in
which to back up the databases on
each server in the DAG.

NSR_USE_CLIENT
_SN_LIST=<yes/
no>

Optional. Specifies
to back up each
mailbox server in
the DAG to a
specific storage
node, based on
what is specified in

the Storage
Node attribute of
each mailbox
server client
resource.

l No (default)—The storage node is

assigned according to the backup
policy.

l Yes—The client resource for the

mailbox server where the secondary
NMM backup process runs provides
the storage node that should be
used.

6. Ensure that Client Direct is enabled.

Exchange backups require Client Direct.

7. Click the Globals (1 of 2) tab and verify that the Aliases attribute displays the
NETBIOS name for the client.

This name is filled in automatically.

The NMM client uses the host computer NETBIOS or “short” name when it
connects to the NetWorker server to browse backups. If the NETBIOS name is
not found, NMM does not display backups.

8. On the Globals (1 of 2) tab, in the Aliases field, type the DAG name.

Include both the short name and full name of the DAG. For example, if
buexch13.net is the domain name and DAG2 is the DAG name, type both DAG2
and DAG2.buexch13.net.
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Figure 11 Adding the DAG name as an alias to a client resource

This step ensures that NetWorker recognizes that the IP-less DAG name is an
alias of the chosen physical mailbox server.

Note

Once the DAG name is added as an alias to a client, do not remove the alias or
add the DAG name to another client resource. If the DAG node configured as
the client resource is unavailable and you must configure a new client, you are
not required to add the DAG name as an alias to the new client.

9. If you are using a NetWorker storage node that is different from the NetWorker
server, when you configure a client resource for the Exchange Server, click the
Globals (2 of 2) tab, and in the Storage node name field, type the storage
node name.

10. Click OK.

11. Create additional client resources for each physical mailbox server in the DAG:

a. In the Administration view of the NetWorker Management Console, click
the Protection tab.

b. In the expanded left pane, select Clients.

c. From the File menu, select New.

d. In the Name field, type the Exchange server name or FQDN.

e. In the Comment field, type a description.

Use this attribute to differentiate the purpose of the resource for each
mailbox server.

f. For the Retention Policy field, select a retention policy from the list.

g. Confirm that the Scheduled Backups field is selected.

h. In the Save Set field, specify the components to be backed up.
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Reconfiguring an IP-less DAG backup to a different node
If the DAG node that is configured as the client resource is unavailable, the backup
fails and you must configure a new client resource. If you are reconfiguring an IP-less
DAG client resource, you must follow additional steps.

Procedure

1. Reconfigure a new client resource from an available physical mailbox server
within the DAG.

2. Remove the old DAG client resource from the backup group.

3. Add the new DAG client resource to the backup group.

Note

Do not delete the old client resource. Do not remove the DAG alias from the old
client resource.

Configuring backups to use a remote storage node in a DAG environment
This topic describes the steps for configuring remote storage in an Exchange database
availability group (DAG) environment. This procedure allows you to specify a storage
node for the physical clients in the DAG, which can differ from the storage node
defined in the federated backup policy.

Note

If you are using a NetWorker 8.2.3 or 8.2.4 server with NMM 19.1 client:

l Configure a regular NetWorker backup group instead of configuring a data
protection policy. Do not enable the Snapshot option.

l If you are using an advanced file type device (AFTD) with NetWorker server 8.2.x,
ensure that the Block based backup checkbox is cleared in the client resource. If
you do not clear this setting, incremental backups are promoted to level full.

l This procedure that creates a client resource when using NetWorker server 8.2.x
is different from the procedure used to create a client resource when using
NetWorker server 19.1. Follow the procedure provided in the "Configuring backups
to use a remote storage node in a DAG environment" section in the NetWorker
Module for Microsoft for Exchange Server VSS User Guide release 8.2 SP1 when
using NetWorker server 8.2.x.

Procedure

1. On each mailbox server that you want to back up, install the NetWorker client
software with the Storage Node option.

2. Open the NMC and create a storage node for each client:

a. On the Devices tab, right-click Storage Nodes and select New.

b. Type the name of the client. For example, node1.domain.com.

c. Right-click Devices, select New, and create the device for the storage node.

d. Label and mount the storage node device.

3. Configure the client to use the storage node:
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a. Right-click Client and select Modify client.

b. On the Globals (2 of 2) tab, in the Storage Nodes field, type the storage
node name. For example, node1.domain.com.

4. For federated backups, also perform the following steps:

a. In the Client Properties window of each DAG client resource, in the
Application Information field, type NSR_USE_CLIENT_SN_LIST=yes.

b. Add the client resources for each physical node to the same group as the
DAG client.

c. In the client resources for each physical node, clear the Scheduled Backup
checkbox.

d. In the Globals (2 of 2) tab, in the Storage node name field, type a name in
the client resources for each physical node.

e. In the data protection policy for the federated backup, ensure that the
selected pool contains the storage node being used for backup.

5. Run the backup and verify that NMM saves the backup to the remote storage
node.

Example of a federated backup
The following figure illustrates a federated backup of a database availability group
(DAG) cluster with three Exchange Servers: MBX1, MBX2, and MBX3. The cluster
contains four Exchange databases: DB1, DB2, DB3, and DB4. Each database can have
only one active copy, but the database can have multiple passive or replica copies. In
this example, there are two passive copies of DB1: one copy is on two different
Exchange Servers (MBX2 and MBX3). Each of the other databases (DB2, DB3, and
DB4) have only one passive copy in the cluster. Only one copy of each database must
be backed up. The preferred server order list specifies that the databases from the
DAG must be backed up in this order: MBX2, MBX3, and MBX1.
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Figure 12 Example of an Exchange Server federated backup

Configuring NetWorker privileges manually
NMM requires that user groups have specific privileges to perform certain operations.

The following table outlines the user group privileges that are required for NMM
backup operations.

Table 26 User group privileges for NMM operations

Operation Required user group privilege

Federated backup Operate NetWorker

Backup deletion Changed Application Settings

Complete the following steps to configure NetWorker user group privileges manually.

Procedure

1. Open the NetWorker Administration GUI.

2. Click Server.

3. In the expanded left pane, click User Groups.

4. Right-click the appropriate user group, and then select Properties.
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The Properties dialog box appears.

5. In the Users field, add the following values for the NMM client host. Type each
value on a separate line:

user=NMM_Exchange_backup_admin_user,host=NMM_client_host
user=system,host=NMM_client_host

where NMM_client_host is the DNS hostname of the NMM client.

6. Click OK.

7. Configure the user group privilege as described in the application-specific user
guides.

Modifying a client resource after upgrading from NMM
version 8.2.x or earlier

After updating NMM from an earlier version, you can modify a client resource using
the Client Properties window.

Note

You can also edit a client resource using the Client Backup Configuration wizard.
When you use the Client Backup Configuration wizard to update an NMM 8.2.x
backup configuration for the first time, you must configure a new backup group and
remove the existing backup group.

Procedure

1. Open NMC and launch the NetWorker Administration UI.

2. In the Administration window, click Protection.

3. From the navigation tree, select Clients, or in the Clients table, right-click the
required client name.

4. Select Modify Client Properties.

5. In the Client Properties window, click the Apps & Modules tab.

6. In the Backup Command field, delete the nsrsnap_vss_save command and
type the nsrnmmsv.exe command. This change must be performed for all the
existing client resources.

7. In the Application Information field, make the following changes:

l If the optional NSR_EXCH2010_BACKUP attribute is set, perform one of the
following:

n Delete the NSR_EXCH2010_BACKUP entry. NMM will use the preferred
default setting to back up database copies.

n Replace the entry with NSR_EXCH_BACKUP=active/passive/preferred
or all.

l If the optional NSR_EXCH_2010_DAG attribute is set, replace it with
NSR_EXCH_DAG= <DAG_name>.

The NSR_EXCH2010_BACKUP and NSR_EXCH_2010_DAG attributes are no longer
supported. If either attribute is specified, the backup will fail.
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8. If required, make other changes.

9. Click OK.

Verifying a backup
To verify that a backup is successful, at a command prompt on the NetWorker client,
type the following:

mminfo -Sot -s NW server -c NMM client
where:

l NW server is the name of the NetWorker server.

l NMM client is the database availability group (DAG) name or Exchange Server
mailbox server name.
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Overview
An Exchange recovery can serve many different purposes. The most granular backup
is of an Exchange database, its log files, and its checkpoint files. Those backups can
be used to recover entire servers, individual databases, or mailbox items.

When you use NMM to back up a Microsoft Exchange Server environment, the
following recovery options are available for stand-alone and high-availability
environments:

l Recover to the original location on the original Exchange server

l Recover to the Exchange Server recovery database (RDB) on the original
Exchange Server

l Recover to an Exchange Server RDB on a different Exchange Server

l Granular-level recoveries for individual mail items and folders
The Granular-Level Recovery chapter and the ItemPoint for Microsoft Exchange
Server User Guide provide information about how to perform granular-level
recoveries.

Recovery types
NMM provides many levels of recovery. For example, you can recover a complete
database or an individual message in a user mailbox.

Database-level recovery
When you recover a database, you generally overwrite the current database unless
you recover to a recovery database (RDB). See Recovering Exchange Server mailbox,
public folder database, or public folder mailbox files on page 98.

Message-level and granular-level recovery
When you must retrieve individual user mailboxes, user mail folders, or messages, you
can do so without overwriting entire mail databases. There are multiple methods you
can use to recover individual mail items. You can mount a database, then browse and
mark items for recovery using ItemPoint for Microsoft Exchange Server. You can also
recover a database to an Exchange recovery database (RDB), and then use NMM GUI
to select and recover individual mailboxes, folders, or messages. The Granular-Level
Recovery Chapter provides the recovery procedures.

DAG recovery
A database availability group (DAG) backup provides access to backups of all
Exchange databases through one NMM client, although the backups come from
multiple Exchange Servers in the DAG. You perform the recovery to the Exchange
Server that is hosting the active database copy. The DAG backup recovery process is
the same as the normal DAG recovery process.

Public mailbox folder and database recovery
You can recover public folder mailboxes (Exchange Server 2013, 2016, and 2019) and
public folder databases (Exchange Server 2010) just as you would any other mailbox
database.
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Recovering an Exchange database
This topic provides an overview of a stand-alone Exchange database recovery.

In a simple Exchange recovery, entire databases are replaced or recovered. When you
recover entire databases, the recovery operation overwrites the current content at
the original location with the recovered data.

The following figure illustrates a simple recovery of the Exchange databases in a
stand-alone Exchange Server environment.

Figure 13 Recovery in a stand-alone Exchange Server environment

In a stand-alone environment, if you do not want to overwrite the current content, you
can recover data to an alternate mailbox database on the same Exchange Server, or
you can recover the recovery database (RDB) and granular-level recovery (GLR) data
to a different Exchange Server. Use the NMM GUI to browse mail folders and locate
individual messages.

The following figure illustrates recovery to an alternate mailbox database in a stand-
alone Exchange Server environment.
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Figure 14 Recovery to an alternate mailbox database in a stand-alone Exchange Server
environment

Recovering individual mailboxes, mailbox folders, and messages
Retrieving and restoring large backups can use significant network, memory,
processor, and storage resources. Depending on the topology and architecture that a
site or organization uses, the recovery operations might also affect production server
performance, which can impact mail users.

NMM provides several methods for recovering individual items, such as user
mailboxes, mailbox folders, and messages, within an Exchange database. These
methods offer several advantages over full-Exchange Server or database recovery:

l You can recover backup data to an alternate location without overwriting the
existing databases or servers.

l You can browse and select individual items from the recovered data, and then
recover the items to the individual’s mailbox.

With NMM, you can recover individual items using one the following methods:

Granular-level recovery (GLR)
NMM mounts the backup set to a virtual drive, where you can browse the backup
content without actually moving or copying the data.

NMM creates this virtual drive quickly and does not require significant disk storage
space. You can browse and select the data, down to the message level, from this
virtual drive, as if you were viewing the actual database.

After you send the recovery request to the NetWorker server, the items are copied
from the backup set to a new Recovered items folder in the user’s mailbox.
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You can browse and select which items to keep, just like any other folder in a mailbox.
GLR saves time and resources by retrieving only the selected items, rather than entire
databases.

Recover to a recovery database (RDB)
You can also recover databases to an RDB, and then browse those databases to select
mailboxes, user folders, or messages for recovery.

When you restore to an RDB, you can browse the database offline, on a separate
server, or from a folder that is separate from the online production Exchange server.

While this method allows you to browse and retrieve items without overwriting the live
Exchange databases or user mailbox, recovery to an RDB requires disk space, network
resources, and processor resources to stage the databases in the RDB.

When you recover to an RDB, it takes time to copy data from one location to another.
NMM recovers the backup to the RDB, then you can browse and retrieve individual
items.

Compare the following figures, which illustrate:

l Recover using NMM granular-level recovery.

l Recover to an RDB, and recover data from the RDB to a user mailbox.
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Figure 15 Recover using NMM granular-level recovery
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Figure 16 Recover to an RDB, and then recover data from the RDB to a user mailbox
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NOTICE

An RDB can be used only for recovering mailbox database data. It cannot be used to
recover public folders.

Exchange recovery prerequisites
Certain prerequisites must be met before you recover Exchange Server data with
NMM:

l Before you perform a recovery, start the Microsoft iSCSI Initiator and Target
services. Otherwise, the recovery fails.

l Verify that the correct version of the Messaging API (MAPI) and Collaboration
Data Objects (CDO) kit is installed. NMM requirements for MAPI client and
collaboration data objects on page 35 provides details.

l If you want to restore an Exchange database to its original location, you must
select This database can be overwritten by a restore in the Exchange
Management Console.
In PowerShell, the flag is called Get-MailboxDatabase -Identity
<DATABASE NAME>|select AllowFileRestore. The Microsoft Exchange
documentation provides more information about this requirement.

l When creating a recovery database (RDB), do not use symbols in the folder name.
RDB item-level recovery fails with an error if the folder name contains a symbol.
For example, the folder name that is used is “Recovered Data - sec77 -
04/03/2013 18:28:45”.

l Exchange does not support restoring public folder mailboxes (Exchange Server
2013, 2016, and 2019), or public folder databases (Exchange Server 2010) to
RDBs.

l During recovery, when you recover mailbox items to a production database, ensure
that the user mailbox is not full. If the allotted mailbox space is exceeded, the
item-level recovery fails.

l When you overwrite existing databases with recovered databases, perform a full-
level backup after every recovery that is performed in Exchange Server. This
action does not apply to RDB or GLR operations.

Requirements for browsing mailboxes
Ensure that the mailbox that you want to browse meets the following requirements:

l Databases must be online. NMM does not display mailboxes in offline databases.

l For Exchange Server 2010 and 2013, the MAPI/CDO 1.21 kit must be installed.

l Exchange System Attendant and Information Store services must be running.

l Log in with the user you created with the NMM Exchange Admin Configuration
tool. The logged-in user must have a configured mailbox with at least one sent or
received message.

l You must have backed up the writer set or database save set:

n For Exchange Server 2010:
Writer: APPLICATIONS:\Microsoft Exchange 2010
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Database: APPLICATIONS:\Microsoft Exchange 2010\Database
n For Exchange Server 2013:

Writer: APPLICATIONS:\Microsoft Exchange 2013
Database: APPLICATIONS:\Microsoft Exchange 2013\Database

n For Exchange Server 2016:
Writer: APPLICATIONS:\Microsoft Exchange 2016
Database: APPLICATIONS:\Microsoft Exchange 2016\Database

n For Exchange Server 2019:
Writer: APPLICATIONS:\Microsoft Exchange 2019
Database: APPLICATIONS:\Microsoft Exchange 2019\Database

Requirements for recovering databases in a DAG
For database availability group (DAG) recovery to the original database, ensure that
the database recovery node and state are correct.

You must perform the recovery to the DAG member server on an active node. The
databases that you want to restore must be in the active state.

Passive copies of the databases must be in Exchange replication suspended state. If
these copies are not in suspended state, you must manually suspend replication copies
before you perform a recovery.

You can suspend replication in the following three ways:

l Use the Exchange Shell command and call the Suspend-
MailboxDatabaseCopy cmdlet

l For Exchange Server 2010, through the Exchange Management Console, in the
Database Copies tab, click Suspend Database Copy

l For Exchange Server 2013, 2016, and 2019, through the Exchange Admin Center,
in the Details pane, under Database Copies, click Suspend

Resume the passive database copies after the restore. The Microsoft documentation
provides further details.

Configuring Exchange Server recovery operations
This section provides the procedures for configuring an Exchange Server recovery.

Specifying Exchange recovery options
Procedure

1. Open the NMM client user interface.

2. Select the NetWorker Server on which the NMM client software was
configured for backup.

3. If the NMM client is part of a cluster, select the virtual client to which you are
recovering data. You can select the virtual client from the client list in the
application toolbar.

4. From the left panel, select Exchange 2010 Recover Session, Exchange 2013
Recover Session, Exchange 2016 Recover Session, or Exchange 2019
Recover Session, and then select one of the following:

l Database Recovery to view Exchange database backups and recover to
recovery database (RDB) and perform either in-place recovery or alternate
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recovery from database backups. This is the default option for Exchange
Server 2010 and 2013 and the only option for Exchange Server 2016 and
2019.

l RDB Mailbox Recover to browse and recover mailbox items from an existing
RDB.

l Granular Level Recover to browse and recover items from databases
without restoring the database to an RDB.

5. In the Exchange Server Session toolbar, click Recover Options.

6. Select the type of recovery to perform:

l To recover data for Exchange Server and retain all existing Exchange
transactions that occurred after the time of backup, select Include existing
logs (Roll forward recovery).

l To recover data for Exchange Server up to the time of backup only, select
Include logs only from this restore (Point-in-time recovery).
After performing a point-in-time recovery, roll-forward recovery cannot be
performed because the point-in-time recovery replaces the logs that were
generated after the backup.

l To mount the database after the restore operation, select Put database
online after restore.

l To recover the database and transaction logs from the backup without
replaying the transaction logs, select Do not replay the transaction logs.
The database cannot be mounted after the restore operation. If you select
this option, you must manually replay the transaction logs by running the
Exchange eseutil.exe utility.

l To specify the number of retries when trying to mount the database, select a
number from the Number of attempts to try before failing on mount list.

l To recover deleted files on the filesystem, select Restore Deleted Database
Files on Filesystem.

7. Click OK to close the Exchange Recover Options dialog box.

8. From the navigation tree, expand the Microsoft Exchange 2010, Microsoft
Exchange 2013, Microsoft Exchange 2016, or Microsoft Exchange 2019
folder.

9. Select the Exchange databases that you want to recover.

10. From the Exchange 2010 Recover Session, Exchange 2013 Recover Session,
Exchange 2016 Recover Session, or Exchange 2019 Recover Session toolbar,
click Recover.

Configuring roll-forward recovery of an Exchange server in a DAG
environment

NOTICE

Perform the recovery from the node where the recovered database is active.

Procedure

1. To identify the Exchange database that must be recovered, use the Exchange
Management Console (EMC), the Exchange Administrative Console (EAC), or a
shell script to determine the database availability group (DAG) member where
the active copy of the database resides.
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The topic Requirements for recovering databases in a DAG on page 85 provides
additional details.

2. In the EMC or EAC application, select This database can be overwritten by a
restore.

3. In the Exchange Management shell, stop replication of any passive copies of the
database with the suspend-MailboxDatabaseCopy command.

For example:

Suspend-MailboxDatabaseCopy -Identity "bv-e15svr1\First Database"

The topic Requirements for recovering databases in a DAG on page 85 provides
additional details.

4. Open the NMM client.

5. Select the NetWorker Server on which the NMM client software was
configured for backup.

6. On the main toolbar, select the Client list, and then select the Exchange DAG
client.

7. From the left pane, select Recover.

8. Select Exchange Recover, and then select Database Recovery to view
Exchange database backups.

9. Click View, and then click Refresh.

10. From the navigation tree, expand the Microsoft Exchange folder.

11. Select the Exchange Server items that you want to restore.

You can select more than one database for recovery. You can select backups of
active or passive databases for recovery.

12. From the Exchange Recover Session toolbar, click Recover.

The Exchange Recovery Options Summary dialog box appears.

13. Review the options:

l If you must change the options, click Recover Options. This action opens
the Exchange Recover Options dialog box, where you can change settings
on the General, NetWorker, Security, and Exchange tabs.

l If the summary does not indicate a roll-forward recovery, click Recover
Options, go to the Exchange tab, and in the Transaction Log File Replay
dialog box, verify that Include existing logs (Roll-forward recovery) is
selected. This default setting might have changed if the previous recovery
was a point-in-time recovery.

l If the options are okay, click Start Recover. This action closes the
Exchange Recover Options dialog box and starts the recovery.

14. Click Restore.

15. After the restore operation completes, restore replication between the nodes
with the resume-MailboxDatabaseCopy command.

For example:

resume-MailboxDatabaseCopy -Identity "bv-hood-e15svr1\First Database"
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NOTICE

Perform a full backup after performing a roll-forward recovery.

Recovery procedures
The following topics describe the procedures to perform a recovery using NMM.

Viewing volumes for backup
To view the volumes that you must back up to protect Exchange server data, use the
NMM GUI to perform either of the following steps:

l Right-click the Exchange Writer-level save set for which you want to view the
volumes, and select Required volumes.
The Required NetWorker Volumes dialog box with details about the volume
appears.

l Select any of the backed-up databases and click Required volumes.
The Required NetWorker Volumes dialog box with details about the volume
appears.

Recovering NetWorker Module for Microsoft Exchange backups
NetWorker Module for Microsoft Exchange (NME) and NMM cannot be installed on
the same client. NME and NMM use some of the same binaries for item-level browsing
and recovery, so running both NME and NMM on the same client causes versioning
conflicts for the common binaries.

Procedure

1. Uninstall NMM. Leave the NetWorker client software running.

2. Install NME.

3. Recover the NME data.

4. Uninstall NME.

5. Reinstall NMM.

Mounting the database after recovery
Certain Exchange pre-restore and post-restore operations enable quick access to
email after recovery. However, until you remount Exchange databases, users cannot
browse and verify email messages. NMM provides options to automatically remount
Exchange databases after restore.

The Exchange administrator decides whether a restore of a particular Exchange
database is required and if an automatic mounting of the database must be done after
the restore is complete. Consider the following points about automatic mounting:

l If automatic mounting is enabled, the database is mounted after the successful
restore of the Exchange Server.

l If automatic mounting is disabled, the administrator must manually mount the
database.
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Performing Exchange Server recovery
This section provides information on performing an Exchange Server recovery.

Performing a full recovery

You can recover the contents of a backed-up database to the original database by
performing full recovery.

Procedure

1. In the NMM user interface, select the NMM client.

2. Click Recover > Exchange Recover Session, and then select one of the
following:

l Database Recovery(default)—Select to view Exchange database backups.

l RDB Data Recover—Select to browse and recover Exchange Server items
from an existing recovery database (RDB).

l Granular Level Recover—Select to browse and recover items from
databases without having to first restore the database to an RDB.

3. If no databases appear, click View > Refresh.

4. In the NMM user interface, select the database.

5. If the database is not listed, specify a browse time that includes the required
backup.

The NetWorker Administration Guide provides details.

6. From the taskbar, click Recover.

NOTICE

Always perform a full backup after performing a point-in-time or roll-forward
recovery.

Performing an advanced recovery
In the NMM user interface, select the NMM client and then select Recover >
Exchange Recover Session  > Database Recovery (default) > Advanced Recover to
recover a database to one of the following locations:

l A selected recovery database (RDB)—Exchange Server 2010 Service Pack 1
Rollup 6 or later,
Exchange Server 2013, 2016, and 2019 support the ability to restore data directly
to an RDB. Mounting the recovered data as an RDB allows you to restore individual
mailboxes or individual items in a mailbox.

Public folders for Exchange 2010 cannot be recovered to an RDB. Public folders
for Exchange 2013, 2016, and 2019 are part of the mailbox database, and thus can
be recovered to RDB.

l An alternate database that is mounted on the mailbox server.

l A remote database—In remote database recovery, a selected mailbox database is
restored to a remote mailbox server in the Exchange database availability group
(DAG) where the active database resides.
The remote database recovery option is available only for Exchange Server DAGs.
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Alternate and remote recoveries are supported only in the same domain.

Performing a DAG database recovery
Procedure

1. Identify the Exchange database that must be recovered:

a. Use the Exchange Management Console (EMC), the Exchange
Administrative Console (EAC), or a shell script to determine the DAG
member where the active copy of the database resides.

b. Log in to the Exchange Server node that is running the active copy of the
database that is to be recovered.

c. If you are recovering to the original database location, open the database
properties and select This database can be overwritten by a restore.

2. Suspend all passive copies of the database that are to be recovered.

The topic Additional requirements for recovering databases in a DAG provides
details.

3. In the NMM user interface, select the NMM client and then select Recover >
Exchange Recover Session  > Database Recovery (default).

4. Select the DAG for recovery:

l To recover normal DAG backups—Select the DAG name for the client on
which the NMM client software was configured for backup.

l To recover IP-less DAG backups—Select the hostname of the physical
mailbox server in the DAG for the client on which the NMM client software
was configured for backup.

5. Select the DAG database to be recovered.

Note

If no databases appear, click View > Refresh.

6. Click Advanced Recover.

The Advanced Recovery dialog box appears. The Steps group lists the three
steps for recovery:

l Select Recovery

l Select DB & Server

l Summary

Click Recover Options to skip the steps for Advanced Recovery and perform
full recovery of the database displayed in Database (Source).

The following figure shows the Advanced Recovery dialog box.
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Figure 17 Advanced Recovery dialog box

7. In the Advanced Recovery dialog box, under Recovery Type, complete the
required steps for the recovery type that you need to perform:

l Recovery Database (RDB) Recovery—To recover to an RDB, perform the
following steps:

a. Select Recovery Database (RDB) Recovery, and then click Next.

b. In the Recovery Database (RDB) Recovery List group, to create an
RDB, click Create.
The Create RDB dialog box appears.

c. In the RDB Name field, type a name for the new RDB.

d. In the EBD File Path field, browse and select the file path location for
the new RDB.

e. In the Log File Path field, browse and select the location for the log file.

f. Click Create.
The new RDB is created and appears in the Manage RDB dialog box.

g. Select the created RDB, and then click Next.

l Alternate Database Recovery—To recover to an alternate database,
perform the following steps:

a. Select Alternate Database Recovery, and then click Next.

b. Select the database that you want to recover to, and then click
NextRecovery Database (RDB) List.

l Remote Database Recovery—To recover to a remote database, perform
the following steps:

a. Select Remote Database Recovery, and then click Next.
The Select Server dialog box appears with a list of remote databases.

b. Select the database to which you want to perform the recovery, and then
click Next.

The Exchange Recovery Summary dialog box appears. This dialog box lists the
Exchange Server Recovery options and the NetWorker Recovery Options. It
also allows you to review the recovery details before you continue.
The following figure shows the Exchange Recovery Summary dialog box.
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Figure 18 Exchange Recovery Summary dialog box

8. To continue with recovery, click Start Recovery.

Recovering to a recovery database (RDB)

RDB recovery is possible only when Exchange 2010 Service Pack 1, Rollup 6, or a later
version of Exchange Server is installed. The following recovery configurations are
possible:

l An RDB can be created and recovered on a DAG member server that has either a
passive or active copy of the database.

l An RDB recovery can be done from any DAG node for any DAG Mailbox databases.

l An RDB recovery can be performed from another mailbox server that is not part of
the DAG but is part of the same Exchange organization.

In a multitenant environment, an administrator is created for each tenant. But when
the user logs in as a domain administrator and performs RDB browsing, there is a
conflict in names due to existence of more than one administrator. To work around
this issue, create a user (for example, NMMBackupUser) and add this user as member
of the Organization Management group to each of the tenants.

RDB browsing fails if the user credentials that are used for the operation have an alias
in the Active Directory. In this situation, you must create a user (without an alias) and
install NMM with the credentials of the new user. Provide the necessary permissions
and use the user account for RDB browsing operations.

Procedure

1. In the NMM user interface, select the NMM client and then select Recover >
Exchange Recover Session  > Database Recovery (default) > Advanced
Recover.

2. In the Advanced Recovery dialog box, select Recovery Database (RDB)
Recovery, and then click Next.

The Manage RDB dialog box appears, as shown in the following figure.
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Figure 19 Manage RDB dialog box

3. In the Recovery Database (RDB) Recovery List group, to create an RDB, click
Create.

The Create RDB dialog box appears, as shown in the following figure.

Figure 20 Create RDB dialog box

4. In the RDB Name field, type a name for the new RDB.

5. In the EBD File Path field, browse and select the file path location for the new
RDB.

6. In the Log File Path field, browse and select the location for the log file.

Previously, due to a Microsoft requirement, the Exchange Server 2010 database
logs path and Mailbox databases that reside on the same volume could not be
stored in the same file path location. This restriction has been lifted.

7. Click Create.

The new RDB is created and appears in the Manage RDB dialog box, in the
Recovery Database (RDB) List.

8. Select the created RDB and click Next.

The Exchange Recovery Summary dialog box appears. This dialog box lists the
Exchange Server Recovery options and the NetWorker Recovery Options. It
also allows you to review the recovery details before you continue.

9. To continue with recovery, click Start Recovery.

Recovering to an alternate database

Alternate database recovery is supported on any mailbox server. In this type of
recovery, the backed-up mailbox database is recovered to a new mailbox database.
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Alternate database recovery is supported in both Exchange Server stand-alone and
database availability group (DAG) environments.

Procedure

1. In the NMM user interface, select the NMM client and then select Recover >
Exchange Recover Session  > Database Recovery (default) > Advanced
Recover.

2. In the Advanced Recovery dialog box, select Alternate Database Recovery for
recovery to an alternate database and click Next.

The Select Database dialog box with a list of alternate databases appears, as
shown in the following figure.

Figure 21 Select Database dialog box

3. Select the database that you want to recover to, and then click Next.

The Exchange Recovery Summary dialog box appears. This dialog box lists the
Exchange Server recovery options and the NetWorker recovery options, and it
allows you to review the details before continuing with recovery.

4. To continue with recovery, click Start Recovery.

Recovering to a remote database
By performing remote recovery, you can start a roll-forward or point-in-time recovery
from a mailbox server that is not actually mounted. After remote recovery starts from
a DAG member server where the Mailbox database is not mounted (the Mailbox
database with the passive copy) the recovery service nsrnmmrc.exe starts in the
DAG member server on the mailbox database with the active copy.

Note

Remote database recovery is supported only in a DAG environment. You cannot
perform a remote recovery to a host that is not a part of DAG.

1. In the Advanced Recovery dialog box, select Remote Database Recovery, and
then click Next.
The Select Server dialog box appears with a list of remote databases.

The following figure shows the Select Server dialog box.
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Figure 22 Select Server dialog box

2. Select the database to which you want to perform the recovery, and then click
Next.
The Exchange Recovery Summary dialog box appears. This dialog box lists the
Exchange Server recovery options and the NetWorker recovery options, and it
allows you to review the details before continuing with recovery.

3. To continue with recovery, click Start Recovery.

Accessing archive mailboxes in recovery databases

Microsoft does not support access to archive mailboxes in the recovery database
(RDB) through MAPI. A MAPI_E_FAILONEPROVIDER (0x8004011d) error occurs
when a MAPI application tries to log in. You can work around this limitation by using
the New-MailboxRestoreRequest cmdlet to restore data from the archive mailbox
in the recovery database.

Procedure

1. Get the archive mailbox GUID from the get-mailbox cmdlet for the user
whose archive mailbox you want to restore. For example, in PowerShell, type:

C:\>Get-Mailbox <alias> | Fl Name, Archive*
...
ArchiveGuid : <GUID>

2. Run the New-MailboxRestoreRequest cmdlet. For example, in PowerShell,
type:

C:\>New-MailboxRestoreRequest -RecoveryDatabase <Recovery
Database Name> -RecoveryMailbox <GUID> -TargetFolder <Target
Folder Name> -Identity <alias>

Results

This action restores the mailbox data to a live mailbox, where the user can work with
it.

For more information about the Restore-Mailbox command, go to http://
technet.microsoft.com/en-us/library/bb125218.aspx and perform a search for
"Restore-Mailbox."
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Recovering a deleted Exchange Server mailbox database, public folder
database, or public folder mailbox database

NMM supports recovering the following Exchange Server databases outside of the
Exchange VSS process:

l Exchange Server mailbox databases

l Exchange Server public folder mailboxes (Exchange Server 2013, 2016, and 2019)
and public folder databases (Exchange Server 2010)

This capability allows you to recover mailbox databases and mailboxes that have been
removed from the Exchange server and the Active Directory. You can also recover
these items so that you can mine data from Exchange public folder mailboxes or public
folder databases with third-party tools.

Procedure

1. In the NMM user interface, select the NMM client, and then click Recover >
Exchange Recover Session  > Database Recovery (default).

If the database is not listed, select a browse time that includes the wanted
backup. The NetWorker Administration Guide provides details.

Although the job summary does not note that the recovery is to a Windows file
system, if the database is online, you cannot overwrite the live database.

2. Select the mailbox database that you want to recover, and then click Recover
Options.

3. Click the Exchange tab, and then click Select Destination.

4. If you are restoring the backup to a database that already exists, then type the
following command at the PowerShell cmdlet:

Set-MailboxDatabase <mailbox_database_name> -AllowFileRestore:
$True
Where <mailbox_database_name> is the name of the database selected as the
destination for the restore operation.

5. Select Restore Deleted Database Files on File System.

6. Browse to the target location where NMM recovers the mailbox database files.

7. Click OK.

8. Recover the deleted Exchange databases.

The following Microsoft TechNet articles provide information about recovering
deleted Exchange mailboxes:

l Exchange Server 2013: https://technet.microsoft.com/en-us/library/
jj863438(v=exchg.150).aspx

l Exchange Server 2010: https://technet.microsoft.com/en-us/library/
bb123490(v=exchg.141).aspx
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Recovering a deleted Exchange Server user mailbox
If an Exchange Server 2010 or later user mailbox is deleted, you can recover the
mailbox with NMM and the Exchange Management Shell tool.

Procedure

1. Perform one of the following steps according to the Exchange Server
environment:

l For Exchange Server 2016 or 2019, perform granular-level recovery on the
deleted user mailbox with ItemPoint for Microsoft Exchange Server.

l For Exchange Server 2010 or 2013, perform granular-level recovery on the
deleted user mailbox with either ItemPoint for Microsoft Exchange Server or
NMM client user interface.

The Granular-Level Recovery chapter provides instructions.

During the granular-level recovery operation, an error message similar to the
following appears:

Error getting item list: Error browsing folders -- Failed to 
fetch mailbox items. Please see libmapibrowse.raw for more 
information. [exch_get_mbx_list]

You can ignore this error message and proceed by clicking OK.

2. Launch the Exchange Management Shell tool.

3. If you are restoring the mailbox to an existing mailbox database, type the
following cmdlet:

Set-MailboxDatabase <target_mailbox_name> -AllowFileRestore:
$True
Where <mailbox_database_name> is the name of the database that is selected
as the destination for the restore operation.

4. To start the restore operation, type the following cmdlet:

new-mailboxrestorerequest -sourcedatabase <GLR_database> -
sourcestoremailbox "<deleted_user_mailbox>" -targetmailbox
"<existing_user_mailbox>" -TargetRootFolder <root_folder_name> -
AllowLegacyDNMismatch
Where:

l GLR_database is the database that was recovered with granular-level
recovery.

l deleted_user_mailbox is the deleted mailbox that you want to recover.

l existing_user_mailbox is the mailbox location where the mailbox is recovered
to.

l root_folder_name is the root mailbox folder where the recovered mailbox is
placed in.

Refer to Microsoft documentation for more information about Exchange
Management Shell tool cmdlets.

5. To monitor the status of the restore operation, type the following cmdlet:

Get-Mailboxrestoreresquest
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6. After the restore operation successfully completes, log in to the target user
mailbox.

7. In the target root folder, verify that the deleted mailbox items are recovered.

8. (Optional) Repeat steps 3 through 7 to recover other user mailboxes.

Performing a quick recovery of a deleted Exchange Server 2010 user mailbox
If a user mailbox is deleted, you can quickly recover the mailbox through the Exchange
Management Console.

The procedure to recover an Exchange Server 2010 deleted mailbox is performed
independent of NMM backup or recovery operations.

Procedure

1. In the Exchange Management Console, from the Recipient management
group, under Disconnected mailbox, ensure that the deleted user mailbox
entry appears.

2. Create a user mailbox with same name.

3. Disable the newly created user mailbox.

4. From the Recipient management group, click Disconnected mailbox, and
then select the user mailbox that was deleted.

5. Right-click the user mailbox, and then click Connect.

6. Select User mailbox, and then click Next.

7. Select Matching user > User mailbox, and then click Next.

The deleted user mailbox is then re-created under Recipient management >
Mailbox.

NOTICE

Re-created mailboxes are not always immediately visible. It might take 15
minutes to 1 hour before the mailbox is visible and accessible through Outlook.

Recovering Exchange Server mailbox, public folder database, or public folder
mailbox files

You can use NMM or ItemPoint for Microsoft Exchange Server to perform a flat-file
recovery or granular-level recovery (GLR) of Exchange Server mailbox databases,
public folder databases, or mailbox database items.

The recovery procedure varies depending on the method you use. The recovery
process is the same for all supported versions of Exchange Server, although the
backup save sets and application information vary depending on the version Exchange
Server you use.

Procedure

1. Backup the database using NMM.

2. Recover the files through one of the following methods:

l Use NMM to perform a flat-file recovery of the database using one of the
following procedures:

n To recover files from a network location: Performing flat-file recovery of
Exchange Server mailboxes, public folder databases, or public folder
mailboxes from a network location on page 99.

Mail Item Recovery

98 NetWorker Module for Microsoft for Exchange Server VSS 19.1  User Guide



n To recover files to a remote computer: Recovering Exchange Server
mailboxes, public folder databases, or public folder mailboxes to a remote
computer on page 99.

l Use ItemPoint for Microsoft Exchange Server to perform a granular-level
recovery of the Exchange flat files.
The Granular-Level Recovery chapter provides more details on performing
GLR.

Performing flat-file recovery of Exchange Server mailboxes, public folder databases, or public
folder mailboxes from a network location

Procedure

1. Log in to the DAG node client where you performed the backup.

2. In the NMM user interface, start a recovery session.

3. From the main toolbar, select Client, and then select the DAG client where you
performed the backup.

4. Click View, and then click Refresh.

5. From the left pane, click one of the following sequences:

l Recover > Exchange 2010 Recover Session > Database Recover

l Recover > Exchange 2013 Recover Session > Database Recover

l Recover > Exchange 2016 Recover Session > Database Recover

l Recover > Exchange 2019 Recover Session > Database Recover

The NMM user interface shows the mailboxes, public folder databases, or public
folder mailboxes that are available for recovery.

6. Select the mailbox database that you want to recover and click Recover
Options.

7. Click the Exchange tab.

8. Select Restore Deleted Database Files on File System.

9. Browse to the target location where NMM recovers the mailbox database files.

10. Click OK.

11. Select the mailbox, public folder, public folder mailbox, or public folder database
that you want to recover.

12. From the Exchange Recover toolbar, click Recover.

13. After the flat-file recovery completes, verify that the logs and .edb files
recovered as expected in the mapped network drive.

Recovering Exchange Server mailboxes, public folder databases, or public folder mailboxes to a
remote computer

To recover the Exchange Server mailboxes, a public folder database, or a public folder
mailbox flat file to a remote computer, you must map a network drive and specify that
network drive path as the value for a new registry entry named
ExchangeDataFilePath.

Procedure

1. On the remote computer that you will recover the database to, create a folder.

For example: E:\folder.
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2. On the database availability group (DAG) node where you performed the
backup, map a network drive to the folder you created on the remote computer.

For example, Z:\ is a mapped network drive on the DAG node, and Z:\ points
to E:\folder on the remote computer.

3. On the remote computer, open the NMM client user interface.

4. From the main toolbar, click Options  > Configure Options.

5. In the Configuration Options dialog box, next to the Client name field, click
Refresh.

6. In the Select Viewable Clients dialog box, click the client where you performed
the backup, and then click Add.

7. Click OK.

8. From the main toolbar, select Client, and then select the DAG client where you
performed the backup.

9. From the left pane, click one of the following sequences:

l Recover > Exchange 2010 Recover Session > Database Recover

l Recover > Exchange 2013 Recover Session > Database Recover

l Recover > Exchange 2016 Recover Session > Database Recover

l Recover > Exchange 2019 Recover Session > Database Recover

The NMM user interface shows the mailboxes, public folder databases, or public
folder mailboxes that are available for recovery.

10. Select the mailboxes, public folder databases, or public folder mailboxes that
you want to recover, and then click Recover Options.

11. Click the Exchange tab.

12. Select Restore Deleted Database Files on File System.

13. Browse to the target location where NMM recovers the files.

14. Click OK.

15. After the flat-file recovery completes, verify that NMM recovered the logs
and .edb files to the folder you created.

Best practices and recommendations for Exchange backup
and recovery operations

Follow the best practices to ensure optimal performance of Exchange backup and
recovery operations.

l As well as scheduled full backups, you should perform a full backup of Exchange
Server after:

n Every successful recovery.

n Upgrading to NMM from previous releases of NetWorker clients.

n Upgrading to a new Exchange version or Service Pack.

n You change the database directory path, the Log Path, or the System Path.

l Ensure that you have mounted all databases before you back up the Exchange
Servers. Unmounted databases are not backed up.
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l If you add a mailbox server to a DAG and then back up one of the databases, either
refresh the NMM user interface, or close the NMM user interface and then reopen
it.

l If you delete Exchange objects such as databases in the Exchange Server, you
cannot recover these objects until you perform disaster recovery. Do not delete
objects from the Exchange Server, unless they no longer need to be recovered.

l After you upgrade from the NetWorker Module for Exchange (NME) to the NMM
client, you cannot recover Exchange backups that were performed with NME. To
ensure that you can recover all Exchange data to the time of the upgrade, perform
a full backup of Exchange data immediately after you upgrade to the NMM client.

l Save sets and backup groups that include the Exchange writer cannot include any
other volumes, applications, or non-Exchange items in the save set.

Exchange recovery limitations
Review the following limitation when backing up and restoring Exchange objects with
NMM.

Roll-forward recovery is not possible after point-in-time restore. After you complete a
successful point-in-time restore, perform a full backup of the Exchange Server so that
you can perform roll-forward recovers.
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CHAPTER 5

Granular-Level Recovery

This chapter includes the following sections:

l Recovering mailbox items with GLR..................................................................104
l Exchange Server GLR by using ItemPoint for Microsoft Exchange Server....... 105
l Exchange Server GLR using the NMM UI..........................................................113
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Recovering mailbox items with GLR
In a conventional Exchange database restore operation, entire databases are replaced
or restored. Retrieving large backups and restoring them can use significant network,
memory, processor, and storage resources and might also affect production server
performance.

NMM supports Granular Level Recovery (GLR), so you can restore individual items
such as individual user mailboxes, mailbox folders, and messages within an Exchange
database. You can browse and select individual folders from the restored data, and
then restore them to the individual’s mailbox.

NMM mounts the backup set to a virtual drive, where you can browse the contents of
the backup without actually moving or copying the data. During the mount process,
NMM copies any required log files from the backup device. The virtual drive is created
and does not require a significant amount of disk storage space. You can browse and
select the recovered data from this virtual drive as if you were viewing an actual
recovery database, down to the folder level.

Only when you send the restore request are actual items copied from the backup set
to the user’s mailbox. If you use the NMM UI for GLR, the items are placed in a
Restored items folder in the user’s mailbox, where you can browse and select the
items to keep. This Restored Items folder is similar to any other folder in the mailbox.

The NetWorker Module for Microsoft Administration Guide provides more information
about GLR.

GLR requirements
You must meet the requirements to recover granular Exchange data using GLR:

l If you are using ItemPoint for Microsoft Exchange Server GLR, you must select
Exchange Granular Recovery when you install the NMM software.

l NetWorker 9.0 or later must be installed on the NetWorker server for Exchange
Server 2010 and 2013.

l NetWorker 9.0.1 or later must be installed on the NetWorker server for Exchange
Server 2016 and 2019.

l In firewall-enabled environments, you must provide firewall exceptions for the
Windows Remote Management services:

1. Click Start > Administrative Tools > Windows Firewall with Advanced
Security > Inbound Rules.

2. In the Inbound Rules dialog box, right-click Windows Remote Management -
Compatibility Mode (HTTP-In), and then click Disable Rule.

3. Right-click Windows Remote Management (HTTP-In), and then click Disable
Rule.

Options for Exchange GLR
Two methods are available for performing Exchange GLR.

You can use one of the following methods to perform Exchange server GLR:

l GLR using ItemPoint for Microsoft Exchange Server.

l GLR using the NMM UI.
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Note

It is recommended that you use ItemPoint for Microsoft Exchange Server to perform
GLR.

If you are unable to use the NMM UI or ItemPoint for Microsoft Exchange Server for
granular-level recovery, you can use the NMM Support Tools for recovery. The
NetWorker Module for Microsoft Administration Guide provides details about these tools.

The following table describes which methods can be used for GLR on each Exchange
Server.

Table 27 Methods for Exchange Server GLR

Exchange Server Available GLR methods

Exchange Server 2010 l GLR using ItemPoint for Microsoft
Exchange Server

l GLR using the NMM UI

Exchange Server 2013 l GLR using ItemPoint for Microsoft
Exchange Server

l GLR using the NMM UI

Exchange Server 2016 l GLR using ItemPoint for Microsoft
Exchange Server

Exchange Server 2019 l GLR using ItemPoint for Microsoft
Exchange Server

Exchange Server GLR by using ItemPoint for Microsoft
Exchange Server

To ensure that a GLR by using ItemPoint for Microsoft Exchange Server succeeds,
review the following information about supported environments and limitations:

Table 28 ItemPoint for Exchange Server requirements

Component Requirement

Browser ItemPoint supports Internet Explorer 8.0 and later.

Operating System The following operating systems are supported:

l Windows Server 2008 R2

l Windows Server 2012

l Windows Server 2012 R2

l Windows Server 2016

l Windows Server 2019

l Windows 7
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Table 28 ItemPoint for Exchange Server requirements (continued)

Component Requirement

l Windows 8

l Windows 10

Note

32-bit and 64-bit versions, virtual and physical, of the listed operating
systems are supported.
Dell EMC ItemPoint can only be run by users with administrative
privileges and in administrative mode.

Source Microsoft
Exchange Database
(offline)

The following versions of Microsoft Exchange Server are supported as
offline source databases:

l Microsoft Exchange Server 5.5

l Microsoft Exchange Server 2000

l Microsoft Exchange Server 2003

l Microsoft Exchange Server 2007 through SP3

l Microsoft Exchange Server 2010 through SP3

l Microsoft Exchange Server 2013 through SP1

l Microsoft Exchange Server 2016

l Microsoft Exchange Server 2019

Target (live)
Microsoft Exchange
Server

The following versions of Microsoft Exchange Server are supported as
live targets:

l Microsoft Exchange Server 2010 through SP3

l Microsoft Exchange Server 2013 through SP1

l Microsoft Exchange Server 2016

l Microsoft Exchange Server 2019

Microsoft Office
(Microsoft Outlook)

You must have Microsoft Outlook 2010 or later x86 (32-bit) version
installed. The following versions of Microsoft Outlook (32-bit versions
only) are supported:

l Microsoft Outlook 2007

l Microsoft Outlook 2010

l Microsoft Outlook 2013

l Microsoft Outlook 2016

l Microsoft Outlook 2019

Virtual environments
Note

Virtual operation of tape devices may have restrictions imposed by
virtual operating systems.

Additional Software Microsoft .NET Framework
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Table 28 ItemPoint for Exchange Server requirements (continued)

Component Requirement

l 3.5 SP1

l 4.0

Note

In order for Dell EMC ItemPoint for Microsoft Exchange Server to
operate fully, you must ensure the Dell EMC software is correctly
licensed for use and the source files are located on Dell EMC storage.
If not, attempts to open a source database will produce an error
message.

User credential and permission requirements
Credential requirements (username and password) vary between tasks when using
ItemPoint for Microsoft Exchange Server. Users may also require permission and
rights to perform the following:

l Connect to target Microsoft Exchange servers

l Create users/mailboxes

l Use multi-tenancy information when opening a source or target

Users may be prompted for credentials during tasks that are based on an
organization's policies. For example, when:

l Connecting to a single mailbox target (not assigned to the ItemPoint for Microsoft
Exchange Server user)

l Connecting to target public folders

The following table provides a guideline for credential and permission requirements:

Table 29 User credential and permission requirements

Activity/Use Case Microsoft
Exchange Role

Credentials/
Authentication

Permissions/
Authorization

Connect to user
mailbox

N/A User Credentials Full Access
Permissions

Connect to other
mailbox

N/A User Credentials Full Access
Permissions

Connect to all
mailboxes

N/A User Credentials Full Access
Permissions

Connect to all
mailboxes without
multi-tenancy

N/A User Credentials Full Access
Permissions

Connect to all
mailboxes with multi-
tenancy

Organizational
Management

User Credentials
(Access limited to
Address Book Policy)

Full Access
Permissions
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Table 29 User credential and permission requirements (continued)

Activity/Use Case Microsoft
Exchange Role

Credentials/
Authentication

Permissions/
Authorization

Create mailbox Organizational
Management

N/A N/A

Mailbox Creation wizard
To use Mailbox Creation Wizard on your computer, you must have the Microsoft
Exchange Server management tools for the version of Microsoft Exchange Server
that you are creating mailboxes on. Ensure the Microsoft Exchange Server
management tools and Microsoft Exchange Server version, service pack, and roll up
level are matched.

For supported operating system and prerequisite requirements for the Microsoft
Exchange Management Tools, please refer to the Microsoft Exchange Management
Tools documentation for the specific version.

Limitations
Consider the following limitations when using ItemPoint for Microsoft Exchange
Server:

l You cannot use ItemPoint to restore NMM 8.2.x and earlier backups (VSS
workflows). To perform granular-level recovery of backups taken with NMM 8.2.x
and earlier, you must use the NMM UI.

l If you have ever copied or moved a message using Microsoft Office Outlook, and
later restored that same item with Dell EMC ItemPoint, the message may be
duplicated. This is because the message ID numbers differ between Dell EMC
ItemPoint and the Microsoft Exchange Server.

l Newly created mailboxes on the Microsoft Exchange Server do not become visible
within ItemPoint until someone has logged on to the mailboxes with Microsoft
Office Outlook, or at least one message is delivered (or copied) to the mailbox.
Until one of these two events occurs, there is no physical mailbox, only directory
information.

l ItemPoint does not check messages or attachments for viruses when restoring
them from the database. If the server antivirus program has current signature
files, it should identify and protect against infected messages when the restored
messages are on the live server.

l Due to the database nature of the PST file and the MAPI subsystem, PSTs opened
as source will be modified.

l Mailbox Creation Wizard is not supported on Windows Server 2012 R2 as
Microsoft Exchange Server 2013 or earlier Management Tools is not supported on
Windows Server 2012 R2.

l The Message Table and Attachment Table Views do not support Microsoft
Exchange Server 2010 or later EDB sources as Microsoft stopped supporting
single instance storage with Microsoft Exchange Server 2010.

l The following ItemPoint features are not supported with Microsoft Exchange
Server 2016 and later:

n Mailbox Creation Wizard
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n Content Analysis Store

n Message views

n Reports

n Exporting organizational forms

l Microsoft Exchange Server 2019 is not supported as live target in configuration
with Outlook 2013 or earlier.

Accessing Exchange backups from a machine where Exchange Server is not
installed

You can configure NMM to access backups of an Exchange Client from a machine
where Exchange Server is not installed.

This procedure is required only when you want to access an Exchange database
backup for ItemPoint granular-level recovery from a machine where Exchange Server
is not installed.

Procedure

1. Open NMC, and then launch the NetWorker Administration UI.

2. Select Server > User Groups > Users.

The User Group Properties window appears.

3. In the User Group Properties window, grant the Remote Access All Clients
user group privilege to the system account and the user account who will be
performing recovery operations.

This step ensures that the user can access backups from Exchange Servers.

4. On the Protection tab, in the left navigation pane, right-click Clients and select
New Client Wizard.

5. Use the Client Backup Configuration wizard to configure a proxy client for the
Exchange client. Specify the backup type as Filesystem.

6. On the proxy Exchange Server, launch the NMM client user interface, and then
select Options > Configure Options.

The Configure Options window appears.

7. In the Configure Options window, in the Backup server name field, type the
name of the pre-configured NetWorker server.

8. Click the refresh button beside Client name.

The Select Viewable Clients window appears with a list of available clients.

9. Select and add the clients with Exchange database backups which you want to
access for granular-level recovery.

Results

After completing these configuration steps, in the NMM UI, when you click Recover >
Exchange Recover Session > Granular Level Recover, the Exchange databases will
be listed in the Browse tree.
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Recovering individual mailbox items with ItemPoint for Microsoft Exchange
Server

Use this procedure to perform GLR on individual mailbox items using ItemPoint for
Microsoft Exchange Server.

The ItemPoint for Microsoft Exchange Server User Guide provides additional information
about GLR procedures.

Procedure

1. Open the NMM client user interface.

2. From the host menu, select the NetWorker client on which the NMM client
software was configured for backup.

3. If the NMM client is part of a database availability group (DAG), select the
virtual client name of the DAG to which you are recovering data. You can select
the virtual client from the client list attribute in the application toolbar.

4. From the left pane, select Recover > Exchange Recover Session > Granular
Level Recover.

5. In the Browse tree, select the mailbox database that contains the items for
recovery.

6. (Optional) To change the database mount options, follow these steps:

a. From the taskbar, click Recover Options.

The Exchange Recover Options window appears.

b. In the Exchange Recover Options window, specify the following values in
the Mount Option pane:

l The mount path. The default mount path is the folder that is specified
during installation.

l The amount of time that the backup is mounted. You can set the time-
out period to 2, 4, 8, 16, or 24 hours. The default time-out period is 8
hours.

The following figure shows the Exchange Recover Options window.
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Figure 23 Exchange Recovery Options window for ItemPoint GLR

7. On the NMM Recover page, in the Browse tree, right-click the selected
mailbox database, and then perform one of the following action sequences.

The following figure shows the menu options for mounting backups for
ItemPoint GLR.

Figure 24 Mounting the backup for ItemPoint GLR

l To mount the backup and launch and configure ItemPoint for Microsoft
Exchange Server in the same action:

a. Select the database, right-click the database, and then click Mount
backup and run ItemPoint.
The ItemPoint Data Wizard appears populated with the source paths for
the backup.

b. In the ItemPoint Data Wizard Source Selection window, review the
source paths for the mounted backup, and then click Finish.

l To mount the backup, and then launch and configure ItemPoint for
Microsoft Exchange Server separately:

a. Select the database, right-click the database, and then click Mount
backup.
Check the Monitor page for messages to verify that the mount operation
was successful.

b. Launch ItemPoint, and then launch the Data Wizard.
The Data Wizard window appears.
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c. On the Source Selection page, specify the source, EDB path and the log
file path for the mounted backup.
The following figure shows the Source Selection page in the Data
Wizard window.

Figure 25 ItemPoint for Exchange Server - Selecting source path

You can find the mount paths on the output on the Monitor page after
mounting the backup, or by right-clicking the database in the Browse
tree of the Recover page and selecting Mount details.

8. Proceed with granular-level recovery using ItemPoint.

The ItemPoint for Microsoft Exchange Server User Guide provides instructions.

Dismounting backups after GLR through ItemPoint for Microsoft Exchange
Server

After you perform GLR using ItemPoint for Microsoft Exchange Server, dismount the
backup using one of the following methods:

l For standard restore operations, the backup is dismounted automatically after the
restore is completed.

l If you changed the mount time in the Exchange Recover Options window, the
backup is dismounted based on the specified timeout setting. The default timeout
period for mounted backups is 8 hours.

l You can manually dismount the backup by right-clicking the Mount Service tray
icon and clicking Dismount Backups.

Note

You can dismount the backup at any time after you initiate GLR, even if ItemPoint for
Microsoft Exchange Server is using the database.

Mount Service system tray icon
The Mount Service system tray icon appears when a backup is mounted.

The following figure shows the Mount Service system tray options.
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Figure 26 Mount Service system tray icon

Right-click the Mount Service system tray icon to choose one of the following
available actions:

l Dismount a backup.

l View mount details.

l Extend timeout period for which the backup is mounted.

Exchange Server GLR using the NMM UI
This section contains the procedures for using the NMM UI to perform GLR on
Exchange Server 2010 or Exchange Server 2013.

You can restore to an Exchange Server recovery database (RDB) without disrupting
the active production databases and servers. After you restore to the RDB, you can
browse and select individual mailboxes to restore to the production server while it is
online.

After a successful GLR and until you perform another GLR or a different type of a
restore operation, the GLR RDB remains mounted and maintains a Read connection
with the original device. You must delete the GLR RDB before you can perform a
Stage operation. Closing the NMM GUI removes the GLR RDB.

Note

When NMM browses folders with more than 10,000 items, NMM might take a
significant amount of time to display these items. In this case, do one of the following:

l Restore the entire folder using Exchange GLR without browsing into the folder.

l Restore the database to an RDB, and then browse from it.

NMM UI GLR requirements
Consider the following requirements before you perform GLR using the NMM UI:

l NMM does not support GLR in an Exchange Server 2016 and 2019 environments
by using MAPI. If you are using Exchange Server 2016 or 2019, perform GLR by
using ItemPoint for Microsoft Exchange Server.

l The backup must be a full backup. Incremental backups are incompatible with
Exchange GLR.

l Public folders or objects cannot be recovered using GLR, and they are not
displayed in the list of folders available for GLR.
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GLR is supported only for backups that reside on GLR-compatible devices, such as
AFTD or Data Domain devices. GLR is also supported with Cloud Boost devices.

Recovering individual mailbox items using GLR through the NMM UI
The recovered items are placed in a new Restored Items folder in the user’s mailbox.

Note

You can mount only one virtual drive at a time and browse one recovery database
(RDB) at a time.

Procedure

1. Open the NMM client user interface.

2. From the host menu, select the NetWorker client on which the NMM client
software was configured for backup.

3. If the NMM client is part of a database availability group (DAG), select the
virtual client name of the DAG to which you are recovering data. You can select
the virtual client from the client list attribute in the application toolbar.

4. From the left pane, select Recover > Exchange Recover Session > Granular
Level Recover.

5. Select the mailbox database to recover.

The following figure shows the NMM UI Recover Browse tree, where you can
browse individual mailbox databases.

Figure 27 Individual mailbox databases

Only full backups are compatible with GLR.

6. From the Exchange Server Session toolbar, click Recover.

l If the backup is GLR-compatible, the recovery continues.

l If the backup is not GLR-compatible, the software prompts you to select a
version of the save set that is GLR-compatible.
To select a GLR-compatible save set:

a. Click Yes.

b. Select a backup from the list of backups.

c. Select Use selected item backup time as the new browse time, and
then click OK.

7. In the Exchange Recovery Summary dialog box, click Start Recover.

8. To clear the Recovered RDB Mailbox Items dialog box, click OK.

9. Expand the database to find user mailboxes and folders, and then select the
items you need to recover. 

10. Click Recover, and then click Start Recover to recover the selected folders.
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After you finish

To recover a different version of the selected database, repeat step 5 through step 10.
Changing to a different version of the database dismounts the currently mounted
virtual drive. NMM creates a new virtual drive with the data from the newly selected
database.

Performing a GLR to an alternate mailbox using the NMM UI
You can recover individual mailbox items, including folders, from any number of active
users to any other active user in the Exchange organization. Recovery is not
supported for deleted users.

Note

Folder names containing forward slashes (/) and backward slashes (\) are not
recovered.

When you recover to an alternate mailbox, NMM creates a Recovered Items folder
under the root of the alternate mailbox. Inside this Recovered Items folder, NMM
creates sub folders that contain the contents of each user’s recovered mailbox items.

For example, you want to recover some of UserYY and UserZZ’s mail items to UserA’s
mailbox. NMM creates a folder in UserA’s mailbox called Recovered Items YYYY-MM-
DD hh:mm:ss, where YYYY-MM-DDD hh:mm:ss indicate the date and time of the
recovery. Inside that folder, NMM creates sub-folders for each user, for example
UserYY and UserZZ, and re-creates each user’s respective folder structure and mail
items.

Procedure

1. Open the NMM client user interface.

2. From the host menu, select the NetWorker client on which the NMM client
software was configured for backup.

3. If the NMM client is part of a database availability group (DAG), select the
virtual client name of the DAG to which you are recovering data. You can select
the virtual client from the client list attribute in the application toolbar.

4. From the left pane, select Recover > Exchange Recover Session > Granular
Level Recover.

5. Select the mailbox database to recover.

The following figure shows the NMM UI Recover Browse tree, where you can
browse individual mailbox databases.

Figure 28 Individual mailbox databases

Only full backups are compatible with GLR.

6. From the Exchange Server Session toolbar, click Recover:

l If the backup is GLR-compatible, the recovery continues.

l If the backup is not GLR-compatible, the software prompts you to select a
version of the save set that is GLR-compatible.
To select a GLR-compatible save set:
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a. Click Yes.

b. Select a backup from the list of backups.

c. Select Use selected item backup time as the new browse time, and
then click OK.

7. In the Exchange Recovery Summary dialog box, click Start Recover.

8. To clear the Recovered RDB Mailbox Items dialog box, click OK.

9. Expand the database to find user mailboxes and folders, and then select the
items you need to recover. 

10. In the Advanced Recovery dialog box, select Alternate Mailbox User.

11. Select the user account for the mailbox:

l To search for a specific user:

a. In the Name dialog box, type a name.

b. Click Search.

c. Confirm the user.

l To list all users in the Exchange organization:

a. Click List All Users.

b. Select the user from the list that appears.

12. Click Next.

The recovery starts.

Performing a GLR on an archive user mailbox using the NMM UI
The NMM software does not support the Exchange Server archive mailbox feature. To
perform an item-level recovery of an archive user mailbox, use the New-
MailboxRestoreRequest command to recover personal PST information from an
recovery database (RDB), which is recovered by NMM.

Procedure

1. Create an archive mailbox with a folder, and add a few email messages to the
folder.

2. Back up the mailbox database that contains the archive mailbox.

3. Perform RDB recovery.

4. Run the following command in the Exchange Management Shell to retrieve the
ArchiveGuid for the archive mailbox:

[>] C:\Windows\system32>get-mailbox arch2 | Fl Name, Archive*
Name : arch2
ArchiveDatabase : ArchiveDB2
ArchiveGuid : 3daa752d-a77c-47b7-ad6e-5a2aa6ee2579
ArchiveName : {Personal Archive - arch2}
ArchiveQuota : 50 GB (53,687,091,200 bytes)
ArchiveWarningQuota : 45 GB (48,318,382,080 bytes)
ArchiveDomain :
ArchiveStatus : None

5. Run the following command in the Exchange Management Shell to recover
Archive PST information:
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[>] C:\Windows\system32>New-MailboxRestoreRequest -
RecoveryDatabase RDB-arch -RecoveryMailbox 3daa752d-a77c-47b7-
ad6e-5a2aa6ee2579 -TargetFolder arch-folder -Identity arch2

6. Confirm that you want to perform the recovery.

Performing a GLR to a PST with the NMM UI
You can recover a user mailbox from any active user in the Exchange organization and
place the recovered mailbox items in a .PST file. Recovery is not supported for deleted
users.

Before you begin

The PST role is not available by default. To configure the role, run the following
PowerShell cmdlet:

New-ManagementRoleAssignment –Role "Mailbox Import Export" –<Exchange
administrator>

where <Exchange administrator> is the Exchange administrator username.

Procedure

1. Open the NMM client user interface.

2. From the left pane, select Exchange Recover Session, and then select a
recovery option.

The following table outlines the different GLR recovery options.

Table 30 Performing a GLR to a PST recover options

Option Description

RDB Data Recover Browse and recover Exchange 2010 and 2013 items from an
existing RDB database. Select this option to perform a PST
export from an existing RDB.

Granular Level Recover Browse and recover items from databases without first having
to restore the database to an RDB. Select this option if no
RDB currently exists.

Note

Database Recover overwrites existing production mailboxes, which does not
produce the correct results.

3. If no databases appear, click View > Refresh.

4. Select the database in the NMM user interface.

If the database is not listed, select a browse time that includes the wanted
backup. The NetWorker Administration Guide provides details.

5. From the taskbar, select Recover.

6. In the Recover Options dialog box, click the Exchange tab.

7. In the PST Target field, type a filepath for the target PST file using universal
naming convention (UNC).
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The UNC file specification should include a file path and file name ending
in .PST. The .PST file does not have to exist, but the NMM GUI must be able to
write to the target location.

8. Click OK.

9. In the Recover dialog box, click Start Recover.

10. In the Exchange Recover Options dialog box, select the location and the name
of the PST file.

Due to a Microsoft restriction, NMM does not support PST recovery for a single
mail item.
If no .PST file is specified, the items that are selected for recovery are
recovered to the production server.

After a recover to the .PST file has completed, the field containing the location
and name of the PST file is cleared.
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CHAPTER 6

Bare-Metal Recovery

This chapter includes the following sections:

l Planning bare-metal recovery........................................................................... 120
l Backing up a standalone Exchange Server for BMR..........................................124
l Backing up an Exchange Server DAG for BMR................................................. 126
l Performing BMR of an Exchange Server...........................................................127
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Planning bare-metal recovery
This section provides an overview of the Windows bare-metal recovery (BMR)
solution and considerations when planning a BMR.

Overview
Bare-metal recovery (BMR) is a technique in the field of data recovery and restoration
where the backed up data is available in a form that allows you to restore a system
from bare metal, that is, without any requirements as to previously installed software
or operating system.

Typically, the backed up data includes the necessary operating system, applications,
and data components to rebuild or restore the backed up system to an entirely
separate piece of hardware. The hardware receiving the restore should have a similar
configuration as that of the hardware that was the source of the backup.

The basic BMR is the process of bringing up a server after a disaster and ensuring that
the system recovers with the operating system, the applications, and the data as they
were at the time of the failure.

Restoring a server to the exact configuration that it had at the time of its destruction
can be a difficult task. When this restoration is performed to another hardware, it can
add to the complexity of the process and can be time-consuming. Windows BMR
solution provides a flexible and reliable method of restoring a server after a disaster.

System requirements
The following sections list requirements to perform Windows BMR. However, the
NetWorker E-LAB Navigator , which is available at https://elabnavigator.emc.com/eln/
elnhome, provides the latest information about the system requirements to perform
Windows BMR by using NMM.

Supported operating systems

The NetWorker E-LAB Navigator , which is available at https://
elabnavigator.emc.com/eln/elnhome, provides information about the operating
systems and versions that NMM supports.

Supported Microsoft applications

The NetWorker E-LAB Navigator , which is available at https://
elabnavigator.emc.com/eln/elnhome, provides information about the Microsoft
applications and versions that NMM supports.

NetWorker software version requirements

The NetWorker E-LAB Navigator , which is available at https://
elabnavigator.emc.com/eln/elnhome, provides information about the NetWorker
software versions that NMM supports.

Use the NetWorker Windows BMR 32-bit ISO image to recover an x86 operating
system on either an x86 or x64 computer.

Use the NetWorker Windows BMR 64-bit ISO image to recover only an x64 operating
system on an x64 computer.
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Microsoft BMR requirements
Perform BMR recoveries to the same or similar hardware, and physical to virtual
environment.

The following Microsoft KB article provides the requirements to perform a BMR to
similar hardware:

http://support.microsoft.com/kb/249694

CPU requirements

Consider the following CPU requirements:

l The operating system architecture and the processor architecture must match.

l Basic Input/Output System (BIOS) or Unified Extensible Firmware Interface
(UEFI) must match.

l You can treat AMD or Intel processors as being the same if they follow the same
architecture. You can recover the operating system backup of an AMD x64
computer to an Intel x64 computer. The process is reversible.

l You can restore the backup of an x86 operating system version only to an x86
processor computer.

l You can restore the backup of an x64 operating system version only to an x64
processor computer.

Hard disk requirements

Consider the following hard disk requirements:

l The disk or RAID drivers that are used in the old system must be compatible with
the disk or RAID controllers in the new system.

l For each critical disk on the BMR target system, the startup hard disk capacity on
the new system must be greater than or equal to the capacity on the old system.
BMR fails if the capacity is smaller by even a single byte.

l Windows BMR supports IDE, SATA, or SCSI hard disks. You can perform the
backup on one type of hard disk and recover on another type. For example, SAS to
SATA is supported.

l You must restore the backup to the same logical disk numbers as on the original
server. You cannot use different logical disk numbers on the target system to
recover the critical volumes such as the operating system volume.

l Ensure that the RAID setup on the destination computer does not interfere with
the disk order of the hard disks.

NIC driver requirements
To use different Network Interface Card (NIC) after a Windows BMR recovery, install
new NIC drivers that match the NIC in the new computer after Windows starts on the
new server.

Critical and noncritical volume requirements

Consider the following critical and noncritical volume requirements:

l Windows BMR backs up only critical volumes, and can be used for offline disaster
recovery. Use the NetWorker client to back up the non-critical volumes.
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Note

NetWorker considers only system volume as a critical volume. If you have installed
a Microsoft application on a drive other than the system drive, the drive is not
considered as critical. On Windows Server 2008 R2, a volume is critical if a
Microsoft application has installed a Windows service on it, but on Windows
Server 2012, a volume that has a Windows application service installed is not
critical.

l To make a volume critical on Windows Server 2012, set the value of the HKLM
\System\CurrentControlSet\Control\SystemWriter
\ReportWin32ServicesNonSystemState registry key to 0. This ensures that
BMR includes the Microsoft application binaries, and the volume on which they are
installed is marked as critical.

Note

This registry key may not be in the registry by default. If it is not in the registry,
create the HKLM\System\CurrentControlSet\Control\SystemWriter
\ReportWin32ServicesNonSystemState registry key.

System Reserved Partition requirements
Ensure that System Reserved Partition (SRP) is online before you perform a BMR
backup. Otherwise, the backup fails and displays the following error messages:

84687:save: Unable to get volume information of file system '\
\?\Volume{245204f6-5ff7-11e2-a3ac-806e6f6e6963}\': The device
is not ready. (Win32 error 0x15). VSS OTHER: ERROR: VSS failed
to process snapshot: The shadow copy provider had an unexpected
error while trying to process the specified operation. (VSS
error 0x8004230f)
90108:save: Unable to save the SYSTEM STATE save sets: cannot
create the snapshot.
86024:save: Error occured while saving disaster recovery save
sets.
If SRP is offline, perform the following steps to bring it online:

1. In the WinPE command prompt, type diskpart and press Enter.

2. Run the following command to display the list of volumes:
DISKPART> list volume

3. Run the following command to select the volume that is offline:
DISKPART> select <volume_name>

4. Run the following command to bring the selected volume online:
DISKPART> online volume

Protecting an environment before a disaster
To prepare for disaster recovery, back up application data and other necessary files.

Procedure

1. Use NetWorker client to back up non-application data.
The NetWorker Administration Guide provides details about using the NetWorker
client to backup non-application files.
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2. If you use a NetWorker server earlier than 9.0.x, create a NetWorker group
without enabling the Snapshot option. Otherwise, create a policy.

3. Create a NetWorker client resource, and assign it to the group that you created
in step 2.

4. Configure the NetWorker client resource by typing ALL in the Save set field,
and clearing the Backup command and Application information fields.

5. Perform a backup.

6. Use NMM to perform a full backup of application data.

The NMM application specific user guides provide details about how to perform
a full backup.

BMR by using NetWorker and NMM
Perform Windows file system backup and recovery by using the NetWorker client, and
application-specific backup and recovery by using NMM.

Note

Specific information about how to backup and recover Microsoft applications in NMM
19.1 is provided in application-specific user guides.

NetWorker disaster recovery provides an automated BMR solution by using the
Windows ASR writer and other VSS writers to identify critical volumes that are
required to perform a disaster recovery on a disabled system. BMR is performed
offline, that is, when the Windows operating system is inactive. This avoids the
necessity to manually reinstall Windows, and the problems that occur when operating
system files are being restored to an active Windows system.

NMM 19.1 is compatible with the NetWorker 19.1 client, which provides a true BMR
capability for Windows Server 2012 R2, Windows Server 2012, Windows Server 2008
R2, and Windows Server 2008. This capability is built into the NetWorker client and
provides BMR support to the same or similar hardware. For Windows BMR, you should
download the ISO recovery boot image file from the Online Support website (https://
support.emc.com). The ISO image provides a wizard that allows you to format disks,
recover Windows critical volumes from backup, and restart the server to bring it back
online.

To support a NetWorker Windows BMR recovery, download the Windows BMR image
from the Online Support website (https://support.emc.com). This download enables
you to create a bootable Windows BMR ISO that contains NetWorker binaries and a
wizard, which controls the recovery process.

The "Windows Bare Metal Recovery to Physical or Virtual Computers" section in the
NetWorker Administration Guide provides detailed information about how to use the
NetWorker Windows BMR image to perform a BMR recovery on protected hosts and
VMware virtual machines.
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NOTICE

For all the Microsoft applications, after performing Windows disaster recovery and
restarting the system, check all the disk and volume configurations. Usually, the disks
and volumes appear as on the original system. 
However, it is possible, especially in BMR scenarios, that the volume or disk signatures
do not match the original ones, and the non-critical volumes or disks are offline and
not mounted. Use the Microsoft Disk Manager to bring the volumes and disks online,
and then restart the system for drive letter reassignments. Assign the same drive
letters that existed before the BMR. Non-critical volumes that the mount points
access might have a similar issue.

Backing up a standalone Exchange Server for BMR
This section contains information about creating client resources to back up a
standalone Exchange Server for bare-metal recovery (BMR).

Creating client resources by using the NetWorker Client Backup
Configuration wizard

Create two client resources to back up the application data and the file system data
which includes the ALL save set.

The Backup chapter provides information about how to create a client resource to
back up the application data.

The "Creating a client resource with the Client Backup Configuration Wizard" section
in the NetWorker Administration Guide provides information about how to create a
client resource to back up the file system data.

Creating client resources by using the Client Properties window
Create two client resources for the standalone Exchange Server. Use one client
resource to back up the system data (critical volumes) and the other client to back up
the application data (non-critical volumes).

Procedure

1. In the NetWorker Management Console Administrator window, create a policy,
a workflow, a group, and an action for system backup.

The Data Protection Policies chapter in the NetWorker Administration Guide
provides information.

2. Create a client resource for system backup:

a. In the NetWorker Administration window, click Protection.

b. In the expanded left panel, right-click Clients and select New.

The Create Client dialog box appears.

c. In the Name field, type the name of the client resource.

d. Click OK.

3. In the right panel, right-click the client resource and select Modify Client
Properties.

Bare-Metal Recovery

124 NetWorker Module for Microsoft for Exchange Server VSS 19.1  User Guide



4. In the Client Properties dialog box:

a. On the General tab:

l In the Protection Group list, select the group that you created in step 1.

l In the Save set field, type ALL.
If you have installed Exchange Server 2013 on a drive other than the
system drive, type the drive letter also. For example, E:\.

b. On the Apps & Modules tab, ensure that the Backup command and
Application information fields are clear.

c. Specify other fields according to the requirements.

d. Click OK.

5. Perform the backup.

Ensure that the backup completes successfully.

6. By using the Administration view of the NetWorker Management Console,
create a policy, a workflow, a group, and an action for application backup.

The Data Protection Policies chapter in the NetWorker Administration Guide
provides information.

7. Create a client resource for application backup.

8. Perform step 2 for the client resource created for application backup.

9. In the Client Properties dialog box:

a. On the General tab:

l In the Group list, select the group that you created for application
backup.

l In the Save set field, type the save set.
For example, APPLICATIONS:\Microsoft Exchange 2019,
APPLICATIONS:\Microsoft Exchange 2016 or APPLICATIONS:
\Microsoft Exchange 2013.

b. On the Apps & Modules tab:

l In the Backup command field, type nsrnmmsv.

l In the Application information field, type the following:
NSR_EXCH_BACKUP=<preferred/passive/Active>
NSR_EXCH_CHECK=<Yes/No>

c. Specify other fields according to the requirements.

d. Click OK.

10. Perform the backup.

Ensure that the backup successfully completes.
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Backing up an Exchange Server DAG for BMR
This section contains information about creating client resources to back up an
Exchange Server DAG for bare-metal recovery (BMR).

Creating client resources
Create client resources for each database availability group (DAG) node and instance.

Manually create client resources to back up the system data (critical volumes) of each
DAG node, including the ALL save set, by using the Client Properties window in NMC.
Then, create one client resource for the DAG instance to back up the application data
(non-critical volumes).

Procedure

1. In the NetWorker Management Console Administrator window, create a policy,
a workflow, a group, and an action for system backup.

The Data Protection Policies chapter in the NetWorker Administration Guide
provides information.

2. Create a client resource for system backup:

a. In the NetWorker Administration window, click Protection.

b. In the expanded left panel, right-click Clients and select New.

The Create Client dialog box appears.

c. In the Name field, type the name of the client resource.

d. Click OK.

3. In the right panel, right-click the client resource and select Modify Client
Properties.

4. In the Client Properties dialog box:

a. On the General tab:

l In the Protection Group list, select the group that you created in step 1.

l In the Save set field, type ALL.
If you have installed Exchange Server 2013 on a drive other than the
system drive, type the drive letter also. For example, E:\.

b. On the Apps & Modules tab, ensure that the Backup command and
Application information fields are clear.

c. Specify other fields according to the requirements.

d. Click OK.

5. Repeat steps 2 through 4 to create client resources for system backup of each
DAG node.

6. Perform the backup.

Ensure that the backup successfully completes.

7. By using the NetWorker Administration GUI, create a policy, a workflow, a
group, and an action for application backup.
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The Data Protection Policies chapter in the NetWorker Administration Guide
provides information.

8. Create a client resource for application backup, including the ALL save set, by
using one of the following methods:

l The Client Configuration wizard—The Backup chapter provides information
about how to use the Client Backup Configuration wizard to create a client
resource to back up the application data.
The "Creating a client resource with the Client Backup Configuration
Wizard" section in the NetWorker Administration Guide provides information
about how to create a client resource to back up the file system data.

l The Client Properties window in NMC—Use the following steps:

a. Perform step a through step d of step 2 to create a client resource for
application backup.

b. In the Client Properties dialog box:

a. On the General tab:

n In the Group list, select the group that you created for application
backup.

n In the Save set field, type the save set.
For example, APPLICATIONS:\Microsoft Exchange 2019,
APPLICATIONS:\Microsoft Exchange 2016 or APPLICATIONS:
\Microsoft Exchange 2013.

b. On the Apps & Modules tab:

n In the Backup command field, type nsrnmmsv.

n In the Application information field, type the following:
NSR_FEDERATED_BACKUP=yes
NSR_FEDERATED_PSOL=<DAG_MEMBER_NODES>
NSR_EXCH_DAG=<DAG_INSTANCE_NAME>
NSR_EXCH_BACKUP=<preferred/passive/Active>
NSR_EXCH_CHECK=<Yes/No>

c. Specify other fields according to the requirements.

d. Click OK.

9. Perform the backup.

Ensure that the backup successfully completes.

Performing BMR of an Exchange Server
Procedure

1. Perform the procedures that the "Performing a Windows BMR to physical or
virtual computers" section in the NetWorker Administration Guide describes.

2. After the recovery completes, restart the host to start all of the Exchange
services.

3. After the host restarts, ensure that you meet the following requirements:

a. You have recovered all critical volumes.
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b. You have created all non-critical volumes with the exact drive letters that
the volumes had before the disaster.

c. You have selected a database, and performed recovery.

d. You have successfully mounted the database after the recovery, and
checked whether the recovery process has successfully recovered all email
messages.
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CHAPTER 7

Troubleshooting

This chapter includes the following sections:

l Troubleshooting logs........................................................................................ 130
l Troubleshooting general errors......................................................................... 130
l Troubleshooting backups...................................................................................131
l Troubleshooting recovery................................................................................. 133
l Troubleshooting granular-level recovery...........................................................135
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Troubleshooting logs
To help you identify problems that occur during NMM operations, diagnostic
information is written to log files during backup and restore operations.

You can control the amount of detail that is included in the debug log files by setting
the debug level while configuring a backup or restore operation. Debug logs are stored
in the <installation_path>\nsr\applogs folder.

Debug log files are separate from the operational logs. They are named using the
timestamp and process ID of the associated operation. The following table shows the
debug log file names for the NMM operations.

Table 31 Debug log files

Operation Log file

Backup nsrnmmsv_<timestamp>.<processid>.
log

Restore nsrnmmrc_<timestamp>.<processid>.
log

Troubleshooting general errors
This section explains how to resolve general issues you might encounter while using
NMM with Exchange Server.

User mailbox structure is distorted in Outlook Web Access after an Exchange
Server 2016 PIT restore operation

Problem

After a point-in-time (PIT) restore operation of an Exchange Server 2016, when
you view a user mailbox with Outlook Web Access, the mailbox structure appears
distorted.

Solution

Clear the cache of the web browser you are using, and then reconnect to Outlook
Web Access. After you clear the cache, the mailbox structure will appear
correctly.

PST export operations stall

Problem

Some versions of Exchange Server 2013 do not create all the necessary Exchange
Security Groups in Active Directory, which can cause PST export operations to
stall in either the Queued or InProgress state.

Solution

Run the Exchange administrator configuration tool to update the administrator
account.

If the PST export operation remains stalled, perform the following steps:

1. Stop the Exchange Search and Exchange Search Host Controller services.
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2. Dismount the database that contains the NMM Backup User's mailbox.

3. Delete the Content Index folder from the database.
This folder is located in the same folder as the database, and its name will be
the GUID assigned to the database. For verification, obtain the GUID by
typing the following PowerShell cmdlet:

Get-MailboxDatabase [database name] -status | fl guid
4. Restart the Exchange Search and Exchange Search Host Controller services.

5. Wait for the content indexing status to become Healthy or Crawling.
View the content indexing status by typing the following PowerShell cmdlet:

Get-MailboxDatabaseCopyStatus [database name]\[server name] |
fl ContentIndexState

6. Retry the PST export.

Troubleshooting backups
This section explains issues that might occur during the backup process for an
Exchange environment, and provides steps to resolve or work around the issues.

Unable to browse mailbox items from a recovered database

Problem

If you are unable to browse mailbox items from a recovered database, you must
restore the original (source) mailbox to an alternate (target) mailbox by running
the New-MailboxRestoreRequest PowerShell cmdlet. Microsoft provides a
full list of syntax and parameters for this cmdlet.

Solution

Use the New-MailboxRestoreRequest PowerShell cmdlet to restore the
mailbox. The following Microsoft article provides more information about this
cmdlet:

http://technet.microsoft.com/en-us/library/ff829875.aspx

The following example shows the New-MaiboxRestoreRequest cmdlet with
sample parameters:

New-MaiboxRestoreRequest -SourceDatabase <RDBNAME> -
SourceStoreMailbox <GUID_OF_MAILBOX_YOU_WANT_TO_RESTORE> -
TargetMailbox <ORIGINAL_USER_MAILBOX> -Targetrootfolder
<Folder_to_restore_into> allowlegacydnmismatch $true

Unmounted or offline databases are skipped

Problem

If a database is unmounted or offline when a backup is performed, the backup
process skips that database. Generally, this omission is not an issue because
databases that are not mounted are not in production.

Troubleshooting

Troubleshooting backups     131

http://technet.microsoft.com/en-us/library/ff829875.aspx


Event log error: Microsoft Exchange Replication service VSS Writer failed

Problem

A failed or canceled backup of a passive copy might write an error in the Event log
that states that the Microsoft Exchange Replication service VSS Writer failed.
However, this condition might be temporary.

Solution

If this backup failure and error occur, perform one of the two following solutions:

l If you must perform an immediate backup, stop and then restart the Microsoft
Exchange Replication Service writer.

l If you wait approximately 15 minutes, the Exchange server automatically
corrects this condition.

NTFS softlinks are skipped by default in Windows VSS backups

Problem

NMM Windows File System backups that use the NMM Windows VSS client skip
NTFS softlinks (also known as symbolic links or symlinks). Also, if an Exchange
Server is configured to save either database files or log files to a softlink path,
backups fail. This issue is known, but a fix is unavailable at this time.

MAPI browsing fails in Client Access Server (CAS) array or Network Load-
Balancing (NLB) setup

Problem

Sometimes, when the CAS server is set to a CAS array or NLB in the NMM user
interface, MAPI browsing fails in Client Access Server (CAS) array or Network
Load-Balancing (NLB) setup. The failure can be due to the NLB configuration,
NLB type, firewall setup, or other error.

Solution

Set up the individual CAS servers to communicate directly with the CAS server in
such setups, instead of creating a CAS Array or NLB through the NMM user
interface.

Unhandled exception occurs during item-level recovery for Exchange Server 2010
GLR RDB

Problem

When you perform item-level recovery to an alternate user mailbox for Exchange
Server 2010 GLR, an unhandled exception might occur.

Solution

Perform the following steps:

1. Close and reopen the NMM UI.

2. Perform GLR.

3. Perform item-level recovery.
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Troubleshooting recovery
This section explains issues that might occur while performing an Exchange recovery,
and provides steps to resolve or work around the issues.

Exchange Server 2010 RDB alternate mailbox item-level recovery fails with error

Problem

Alternate mailbox item-level recovery for Exchange Server 2010 RDB fails with
error:

An unspecified error has occurred. 1 0 19 E_FAIL.

Solution

The target user must log in to the mailbox through the Outlook Web Application
and send a few test mails, and then perform item-level recovery to target user
mailbox.

Unhandled exception occurs during item-level recovery for Exchange Server 2010
GLR RDB

Problem

When you perform item-level recovery to an alternate user mailbox for Exchange
Server 2010 GLR, an unhandled exception might occur.

Solution

Perform the following steps:

1. Close and reopen the NMM UI.

2. Perform GLR.

3. Perform item-level recovery.

In Exchange Server 2010, an unhandled exception occurs when mounting an RDB
after failed recovery

Problem

Occasionally, after a failed RDB recovery, when the RDB is dismounted and the
NMM user interface is left open for a few days without use, when the RDB is
remounted, an unhandled exception occurs.

Solution

Close and reopen the NMM user interface.

In Exchange Server 2010, RDB item-level recovery fails with “insufficient
permissions to access mailbox” error

Problem

If the mailbox database where the currently logged-in user mailbox resides is not
mounted, an RDB item-level recovery might fail with the following error message:

Insufficient permissions to access mailbox

Troubleshooting

Troubleshooting recovery     133



Solution

To browse the contents in RDB, ensure that the mailbox database where the
currently logged-in user mailbox resides is mounted. MAPI communicates with
the RDB mailbox through the currently logged-in user mailbox.

For example, if the user is logged in as Administrator, the mailbox database that
contains the Administrator mailbox should be mounted.

Cannot browse Exchange Server 2010 RDB on a stand-alone server

Problem

Exchange Server 2010 must have an administrative mailbox to browse an RDB
with NMM. This mailbox is created by default. Occasionally, the Active Directory
entry for this mailbox becomes corrupt which causes Exchange to respond with
one of the following reactions:

l The mailbox does not exist.

l The user (administrator) already has a mailbox and does not let you create a
mailbox.

Solution

Perform the following steps:

1. Manually remove all Exchange Active Directory entries for the administrator
using ADSI edit.
The administrator is visible.

2. Re-create a mailbox for the administrator.
After the new mailbox is created, you can browse the RDB.

Mounting a database after a restore operation fails

Problem

After successfully restoring an Exchange backup, when you try to mount the
Exchange database the mount operation may take an extended period of time or
fail altogether.

Solution

Use the following steps to disable automatic mounting after the restore operation
and manually bring the database online.

1. In the Exchange Recover Options dialog box, clear the Put database online
after restore option to disable automatic mounting.

2. After a restore operation, bring the database online manually with the
following commands:

a. Run the following eseutil command:

ESEUTIL /R Enn /I /D[database_path] /S[chk file_path] /
L[log_file_path]

b. Run the following PowerShell cmdlet:

mount-database -identity <dbname>
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Troubleshooting granular-level recovery
Troubleshooting ItemPoint for Microsoft Exchange Server GLR
To verify that ItemPoint for Microsoft Exchange Server is properly configured, run the
NMM Configuration Checker on the NMM client. The ItemPoint for Microsoft Exchange
Server User Guide provides information about troubleshooting ItemPoint GLR.

Troubleshooting NMM UI GLR

NMM UI GLR failing after upgrade

If you try to perform GLR after upgrading to a newer version of NMM, the
operation can fail. To resolve this issue, delete the following MAPI profile registry
keys in the following order:

1. HKEY_LOCALMACHINE\Software\Legato\NetWorker
\RecoverOptions\MapiProfile

2. HKEY_CURRENT_USER\Software\Microsoft\Windows NT
\CurrentVersion\Windows Messaging Subsystem\Profiles
\Legato NetWorker

After you delete these registry keys, GLR operations should complete
successfully.

NMM UI GLR failing with MAPI error

After successfully importing a mailbox from an RDB, browsing and GLR of the
RDB fails with a long message including the text Unable to query MAPI
interface. To resolve this issue, add one of the following registry keys as
appropriate to override either the proxy server or CAS server behavior:

l If the current server is not an RPC Proxy Server, add HKEY_LOCAL_MACHINE
\SOFTWARE\Legato\NetWorker\VSSClient\RPC ProxyServer

Note

This registry key is only applicable to Exchange Server 2013 and later.

l If the current server is not a CAS server, add HKEY_LOCAL_MACHINE
\SOFTWARE\Legato\NetWorker\VSSClient\CAS Server

Exchange GLR failing to establish a Client Direct session

Problem

The Exchange Server fails to establish a Client Direct session. The Client Direct
feature must be enabled to perform GLR.

Solution

To verify that the environment has Client Direct enabled, perform the following
steps:

1. Validate that the NetWorker device is enabled for Client Direct.
This verification must only be performed for AFTD devices. Data Domain is
automatically enabled for Client Direct. The NetWorker Administration Guide
provides more information about Client Direct.

2. Validate that the client has name resolutions for the systems.
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If Data Domain is being used, ensure the client has name resolution for the
Data Domain device. If an AFTD storage node is being used, ensure the client
has name resolution for the storage node.

3. Check the application logs directory in the NetWorker Virtual File System
(NWFS) log file, nwfs.raw, and look for messages confirming that a Client
Direct session was established.

l The message "Performing Direct File Access Restore"
confirms that a Client Direct session is successfully established.

l The following messages indicate that a Client Direct session could not be
established:

n Configured to perform Immediate recover, exiting
n Configured to perform Non-Immediate recover, exiting

4. Run the following save command from the command prompt:

PS C:\Program Files\EMC NetWorker\nsr\bin> save -D1 -a
DIRECT_ACCESS=yes -b networker_pool 'C:\Windows
\System32\drivers\etc\hosts'

Where networker_pool is the NetWorker pool containing the volumes where
the save sets for recovery reside.

5. Check the output for messages indicating the Client Direct session is
established:

10/16/16 23:59:27.094472 Default DFA handling by client is 
'Fallback'
10/16/16 23:59:27.094472 DIRECT_ACCESS=yes: Client direct set 
to 'Yes'
10/16/16 23:59:27.129477 Device attribute block size is 262144
10/16/16 23:59:29.185589 libDDBoost version: major: 3, minor: 
3, patch: 0, engineering: 2, build: 545054
10/16/16 23:59:29.197590 load ddp_get_file_segment_type
129292:save: Successfully established Client direct save 
session for save-set ID '889485007' (mb-vm-sql-2.dpsg-sea.emc.c
om:C:\Windows\System32\drivers\etc\hosts) with Data Domain 
volume 'ddveselssemccom.002'.
10/16/16 23:59:29.299596 using DFA save for ssid = 889485007
10/16/16 23:59:29.299596 ssid 889485007 using DFA save to `mb-
vm-nw-2'
10/16/16 23:59:29.299596 Successfully setup direct saves

6. (Optional) If the save command fails:

a. Run the save command again after replacing -D1 to -D3:

PS C:\Program Files\EMC NetWorker\nsr\bin> save -D3 -a
DIRECT_ACCESS=yes -b networker_pool 'C:\Windows
\System32\drivers \etc\hosts'

Where networker_pool is the NetWorker pool containing the volumes
where the save sets for recovery reside.

b. Check for output messages indicating the Client Direct session is
established.

c. If a Client Direct session is not established, find the messages indicating
the cause of the failure, and fix the problem as required.
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Cannot enable a Client Direct session and GLR failing as a result

Problem

Client Direct is required for Exchange GLR, including GLR of backups taken with a
previous version of NMM. If you cannot enable Client Direct for either policy or
technical reasons, use the following workaround to allow GLR to continue without
Client Direct.

Solution

1. Create a folder and name it "debug" in the \nsr\ directory, if the folder does
not already exist.

2. Within the "debug" folder, create an empty file and name it "nodirectfile" with
no file name extension.

You may be required to create the "nodirectfile" file from a DOS Shell
command line.

NOTICE

This workaround disables Client Direct for all client operations, including
subsequent backups. This workaround is against NMM best practices and you
may run into timeout and other restore issues if you do not enable Client Direct.
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